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Preface 

Preface Sections: 

• Purpose of this Guide 

• Who Should Use this Guide? 

• Conventions 

 Warning 
Only qualified electrical personnel familiar with the construction/ 
operation of this equipment and the hazards involved should install, 
adjust, operate, and/or service this equipment. Read and understand this 
guide in its entirety before proceeding. Failure to observe this precaution 
could result in severe bodily injury or, in extreme cases, loss of life. 
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Purpose of this Guide 
This manual explains how to install, configure and operate the SST-PB3-SLC scanner. 

Who Should Use this Guide? 
Use this manual if you are designing, installing, programming or troubleshooting control systems 
that use Allen-Bradley SLC processors and the SST-PB3-SLC scanner. 

You should understand PLCs and have basic knowledge of SLC products. Familiarity with  
PROFIBUS modules and the PROFIBUS network would be an asset. 
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Conventions 
This guide uses stylistic conventions, special terms and special notations to help enhance your 
understanding. 

Style 

The following stylistic conventions are used throughout this guide: 

Bold  indicates field names, button names, tab names, command names and 
options or selections 

Italics indicates keywords (indexed) or instances of new terms and/or specialized 
words that need emphasis   

CAPS indicates a specific key selection, such as ENTER, TAB, CTRL, ALT, 
DELETE 

Code Font  indicates command line entries or text that you would type into a field 

Underlining  indicates a hyperlink 

“>” delimiter  indicates how to navigate through a hierarchy of menu selections/options 

“0x” or “-H”  indicates a hexadecimal value 
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Terminology 

The following special terms are used throughout this guide: 

Card The SLC 500 network interface card 

Channel A PROFIBUS network interface on the card 

Firmware The embedded software module that gets loaded to the scanner’s memory 
and runs on the scanner, enabling it to respond to commands from the host 
and manage network communications. 

Module  A synonym for Scanner 

Scanner The SST-PB3-SLC scanner module, consisting of hardware and firmware 
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Special Notation 

The following special notations are used throughout this guide: 

 Warning 
Warning messages alert the reader to situations where personal injury 
may result. Warnings are accompanied by the symbol shown, and 
precede the topic to which they refer. 

 

 Caution 
Caution messages alert the reader to situations where equipment damage 
may result. Cautions are accompanied by the symbol shown, and 
precede the topic to which they refer. 

 

 

Note 
A note provides additional information, emphasizes a point, or gives a 
tip for easier operation. Notes are accompanied by the symbol shown, 
and follow the text to which they refer. 
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1 
Overview 

Chapter Sections: 

• System Overview 

• Hardware Features 
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1.1  System Overview 

1.1.1  Scanner Capabilities 

The SST-PB3-SLC is the PROFIBUS scanner for the SLC 500. It enables communication 
between an SLC processor (SLC 5/03 or later) and DP remote I/O devices on a PROFIBUS 
network, acting as a PROFIBUS DP remote I/O scanner. It: 

• Can scan up to 125 Slaves 

• Supports up to 244 bytes of input data and 244 bytes of output data per Slave 

• If you use the SST PROFIBUS Configuration Tool to configure the scanner,  
you can have up to 1032 words of input data and 1032 words of output data 

• If you use Siemens’s COM PROFIBUS to configure the scanner, it supports up to 
160 words of input data and 160 words of output data  

• Can reside in any slot in the local SLC chassis except slot 0 (reserved for the SLC 
processor). You can have multiple scanners in the same rack. 

• Supports all standard PROFIBUS baud rates (9600, 19200, 31.25k, 45.45k, 93.75k, 
187.5k, 500k, 1.5M, 3M, 6M, 12M) 

• Can act as a DP Slave to another DP Master on the same network 

• Supports up to 122 words of input data and 122 words of output data as a Slave 

• Supports up to four FDL SAPs and up to four FDL message blocks 

• Supports DPV1 Master Class 1 and Class 2  messaging 
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1.1.2  Configuring the Scanner 

You can configure the I/O on the DP network using either the SST PROFIBUS Configuration 
Tool or Siemens’s COM PROFIBUS configuration software.  

The SST PROFIBUS Configuration Tool allows you to upload the configuration directly to the 
card, via the scanner’s serial port. The COM PROFIBUS exports the configuration to a *.2bf file 
(binary), which you can upload from any serial communications software via an Xmodem 
transfer. 

The scanner stores the configuration in its flash memory, so you don't need to upload the 
configuration every time you start the SLC, and because all configuration is done with the 
Configuration Tool or COM PROFIBUS, you don’t need to set up a G file in the SLC. 

1.1.3  Input and Output Data 

Input and output data for the Slaves is mapped into SLC I, O, M0 and M1 files. The mapping 
depends on the addresses you assign in your configuration.  

The SLC processor scan and the scanner I/O scan are independent (asynchronous) of each other. 
The processor reads the scanner input data during its input scan and writes the output data during 
its output scan. The scanner continues reading input data from the Slaves and writing output data 
to the Slaves, regardless of what the SLC is doing. 
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1.1.4  Scanning Network and I/O Status 

The scanner maintains the following status information about the network and connected 
modules:  

• Slave status for each Slave  

• Network diagnostic counters  

• DP Master diagnostic counters  

• FDL diagnostic counters 
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1.2  Hardware Features 

Figure 1:   Front of SST-PB3-SLC Scanner 
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The following table describes the parts of the scanner. The scanner’s side label provides module 
information. 

Table 1:    Scanner Parts 

Feature  Function 

Status LEDs  Display the communication and system status  

Front Label  Identifies the scanner  

9-pin PROFIBUS Connector  Used for connecting to the PROFIBUS network  

Self-Locking Tabs  Secure the scanner in the chassis slot  

Side Label (Nameplate)  Provides module information  

Configuration Port  Used for uploading I/O configuration data  
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1.2.1  LEDs 

The scanner has two LEDs: the SYS LED and the COMM LED. For detailed information refer 
to Section 3.3  , Status LEDs. 

COMM LED 

At powerup, the COMM LED flashes green, red, amber then off.  

The COMM LED indicates the health of the PROFIBUS network and flashes green when the 
PROFIBUS scanner is token passing or being monitored via the Configuration Tool. The LED is 
solid green when there are no network errors. If a network error occurs, the COMM LED can 
either be off, solid red, or flashing red periodically while it is green.   

SYS LED 

At powerup, the SYS LED flashes green, red, amber, red then off. While it flashes, you can enter 
System Configuration mode to download new firmware to the scanner.  

When the scanner acts as a Master, the SYS LED indicates the communication status with 
PROFIBUS slaves. A solid red SYS LED indicates that one or more slaves are in error, and solid 
green means that all slaves are being scanned on the network in Run mode. When it’s amber, all 
slaves are being scanned in Program mode (outputs are all zeroes).  

When the scanner acts as a slave, the SYS LED indicates the communication status with the 
PROFIBUS Master. When the SYS LED is solid red, the PROFIBUS Master is no longer 
scanning, and when it is solid green, the PROFIBUS Master is successfully scanning the module 
as a slave in Run mode. An amber SYS LED indicates that the PROFIBUS Master is scanning 
the module as a slave in Program mode. 
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1.2.2  9-pin PROFIBUS Connector 

The PROFIBUS connector connects the scanner to the PROFIBUS network. 

1.2.3  Configuration Port 

Use the configuration port to upload I/O configurations from the SST PROFIBUS Configuration 
Tool or to export them from the Siemens COM PROFIBUS to the scanner. 
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2 
Scanner Quick Start 

Chapter Sections: 

• Overview 

• Equipment and Tools 

• Package Contents 

• Power Requirements 

• Procedures 
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2.1  Overview 
This chapter provides information to get you up and running quickly. It: 

• Tells you which tools and equipment you need 

• Mentions preliminary considerations 

• Describes how to address, configure and program the scanner module 

• Explains how to wire and install the scanner module 

• Discusses system power-up procedures 

 

Note 

The procedures in this chapter assume that you have a basic 
understanding of process control, and are able to interpret the ladder 
logic instructions that control the applications. 

This chapter does not include detailed explanations of these procedures, 
but refers to later sections and chapters. If you have any questions or are 
unfamiliar with the terms used or concepts presented, read the 
referenced chapters and other documentation before you proceed. 

 

 

Note 
Before performing the procedures outlined in this section, ensure that  
the latest version of the software has been downloaded to the module. 
The firmware is available on the Molex web site at: 

http://www.molex.com/ 

 

http://www.molex.com/
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2.2  Equipment and Tools 
Have the following tools and equipment ready: 

• SLC programming equipment 

• SST PROFIBUS Configuration Tool, or Siemens COM PROFIBUS software 

• Communication software 

• Null modem cable 

• PROFIBUS cable to connect the scanner to the PROFIBUS network 

2.3  Package Contents 
Unpack the module. Make sure that the contents include:  

• The PROFIBUS scanner  

• A serial null modem cable for uploading I/O configurations  

• A CD with files for Windows XP/Server 2003/Vista/Server 2008 and Windows 7 32-bit 
and 64-bit installation 
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2.4  Power Requirements 
Review your system’s power requirements to make sure that your chassis supports placement of 
the scanner module. 

 

Note 
The scanner consumes 750 mA @ 5VDC.  

For modular systems, calculate the total load on the system power supply 
using the procedure described in the SLC 500 Modular Style Installation 
& Operation Manual, Allen-Bradley Publication 1747-6.2, or the SLC 
500 Family System Overview, Publication 1747-2.30. 

2.5  Procedures 
The setup of the SST-PB3-SLC PROFIBUS Scanner is divided into two parts:  

1. Setting up the scanner.  

2. Getting the scanner running. 
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2.5.1  Setting up the Scanner 

 Warning 
Before working on or around this equipment, ensure that system power 
is off. 

1. Insert the scanner module into your 1746 chassis.  

2. Connect the scanner to the PROFIBUS devices, using appropriate cabling and 
termination. For more information, refer to Section 3.2, Wiring.  

3. Set up your system I/O configuration for the particular slot in which you installed the 
scanner.  

4. Set the module type to Other, and enter the scanner module ID (13635) at the prompt. For 
more information, refer to Section 1.1.2, Configuring the Scanner.  

5. Set the M0 and M1 file sizes to 4200. 

 

Note 
If you do not set the M0 and M1 file sizes, the programming device will 
not let you access the M files in the SLC control program. For more 
information, refer to Section 1.1.2, Configuring the Scanner.  

If you are using fewer than 32 input words or 32 output words, you can 
reduce the size of scanned inputs or scanned outputs. 

6. Write the rest of the control program that will use the scanned data.  

7. Apply power to the SLC.  

8. Put the SLC in Program mode and transfer the program to the SLC. For details, refer to 
your programming software manuals. 
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2.5.2  Getting the Scanner Running 

1. Install the SST PROFIBUS Configuration Tool.  

2. From the Windows distribution disk, run setup.exe.  

3. Create your I/O configuration. For more information, refer to Section 4.2, Creating an I/O 
Configuration.   

4. Create a new file.  

5. Select the Master station number.  

6. Configure the bus parameters and set the network baud rate.  

7. Configure the Slave parameters for each Slave, set the Slave station number and Slave 
module type, and assign I/O addresses to the Slave. 

8. Right-click on the Master and select Connect. 

9. Right-click on the Master and select Load Configuration. 

10. Put the SLC in run mode. The module is now scanning I/O. 
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3 
Installing and Wiring the Scanner Module 

Chapter Sections: 

• Installing the Scanner Module 

• Wiring 

• Status LEDs 
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3.1  Installing the Scanner Module 
Installation procedures for the scanner module are the same as for any other SLC module.  
To identify the chassis and module components listed in the installation procedures, refer to 
Figure 2.  

 Caution 
Before attempting to install, remove or wire the scanner, disconnect 
system power. Adding or removing the module with the power on may 
cause electrical damage. 

 
 

 

Note 
Before installation, make sure that your modular SLC power supply has 
adequate reserve current capacity. The scanner requires 750 mA at  
5 VDC. 

Figure 2:   Chassis and Module Components 
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To install the scanner module: 

1. Disconnect power. 

2. Align the full-sized circuit board with the chassis card guides. The first slot (slot 0) of the 
first rack is reserved for the SLC 500 processor. 

3. Slide the scanner module into the chassis until the top and bottom latches catch. 

4. Attach the PROFIBUS cable. For cabling information, refer to Section 3.2.1, PROFIBUS 
Wiring. 

5. Turn on termination as required (the stations at one of the two physical ends of each 
segment must be terminated). 

6. Route the cable down and away from the scanner. 

7. Cover all unused slots with the card slot filler, Allen-Bradley catalog number 1746-N2. 

8. Power up the system. 

 

Note 
If there is a lot of electrical noise in your installation, you need to install 
an isolating transformer. For instructions, refer to Allen-Bradley’s 
Installation and Operation Manual for Modular Hardware Style 
Programmable Controller, AB 1747-6.2. 
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3.1.1  Removing the Scanner Module 

1. Disconnect power. 

2. Remove all cabling from the scanner. 

3. Press the releases at the top and bottom of the module and slide the module out of  
the slot. 

4. Cover all unused slots with the card slot filler, Allen-Bradley catalog number 1746-N2. 

5. Place the scanner into the static protective bag supplied with shipment packaging and 
store it in the original box in a dry and cool environment. 

3.2  Wiring 

3.2.1  PROFIBUS Wiring 

The module contains a standard DB9 connector, which can be connected to a PROFIBUS bus 
terminal. The module has no termination but the bus terminal has built-in switchable termination.  

DB9 Instructions 

Table 2:    DB9 Instructions 

Pin #  Pin Description  DB9 Termination when Using SST-PB3-SLC  

1  Chassis ground   

2  Reserved   

3  Data +  Connect this pin to pin 8 (data -) with 220 ohm 
resistor  

4  TX Enable   

5  Isolated ground  Connect this pin to pin 8 (data -) with 390 ohm 
resistor  

6  Isolated +5V  Connect this pin to pin 3 (data +) with 390 ohm 
resistor  

7  Reserved   

8  Data   

9  Reserved   
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Selecting the Proper Line Type  

Use this table to determine which line type best suits your system requirements.  

Table 3:    Line Types 

Baud Rate (bits/s)  Line A Distance (Max)  Line B Distance (Max) Total Capacitance of All Drop 
Cables  

9k6, 19.2k, 31.25 k, 
45.45 k and 93.75k  

1200 m**  1200 m** *15nF  

93.75k  1200 m**  1200 m** *3nF  
187.5k  1000 m**  600 m** *1nF  
500k  400 m**  200 m** *0.6nF  
1.5M  200 m**  NA  *0.2nF  
3, 6 and 12M  100 m**  NA  *0.05nF 
NA = Not Applicable  
*If using a combination of both line types, divide the lengths shown by two.  
**This is the sum of all bus segment and drop cable lengths. 
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PROFIBUS Connector 

The card has one standard PROFIBUS DB9 female connector per channel. Pin numbers are 
identified in the following figure. 

Figure 3:   The PROFIBUS DB9 Female Connector 

12345

6789  

  

Note 
The recommended male connector is the Brad Harrison PA9D01-42 
Diagnostic D-Sub Connector. 

The two physical ends of the network should be terminated. There should be only two 
terminators on a network. 

The recommended cable is a Belden3079A. Examples include:  

• Brad Harrison 85-001 PVR2 conductor with shield, UL-listed PROFIBUS cable 

• Bosch Comnet DP #913 548 Flexible PROFIBUS Cable 

• Bosch Comnet DP #917 201 Trailing PROFIBUS Cable  

• Bosch Comnet DP #917 202 Massive PROFIBUS Cable  

 

Note 
Allen Bradley blue hose, which has an impedance of 78 ohms, is not 
recommended. 

 

 Caution 
Do NOT Connect devices to the +5V line. It is there for termination 
purposes only. 
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3.2.2  Serial Port Wiring 

Before scanning I/O, use the serial CONFIG port on the front of the scanner to upload an I/O 
configuration file. 

 

Note 
Pins 2 and 3 of the serial port are wired the same as a PC 9-pin COM 
port, so the serial cable for a standard PC COM port must have lines 2 
and 3 swapped. The serial connection doesn’t require handshaking.  

Connect to the serial port using any communication software, such as Windows Terminal  
or HyperTerminal. The scanner serial port supports any baud rate from 9600 baud to  
115 kbaud, with no parity, 8 data bits, and 1 stop bit. Set the Flow Control to None.  
The scanner automatically detects the baud rate you are using by adjusting the baud rate  
until it receives an “*”. 

Figure 4:   Serial Port Wiring 

 

For an example of configuring the card as a Slave using a communications software package 
over the serial port, refer to Section 7.6, Displaying the DP Slave Configuration.  
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3.3  Status LEDs 

3.3.1  SYS LED 

If you are using the scanner as a DP Master and a DP Slave, the SYS LED shows the status of 
both operations sequentially. The Master status is flashed first, followed by the Slave status.  
If you are using the scanner for FDL, the sequence is DP Master, DP Slave, FDL messages and 
FDL SAPs.  

The SYS LED also flashes an 8-bit error code if an internal fatal error occurs, alternating red for 
0 and green for 1.   

The following tables provide a description of the LEDs.  

Table 4:    DP Master 

Color  Meaning 

Red  One or more Slaves is reporting a fault condition.  

Amber  The module is in Program or Test mode.  

Green  The module is scanning in Run mode. 

Table 5:    DP Slave  

Color  Meaning 

Red  The Slave is not being scanned or is faulted.  

Amber  The Slave is being scanned in Program mode.  

Green  The Slave is being scanned in Run mode.  

Table 6:    FDL  

Color  Meaning 

Red  A fault has occurred.  

Green  The system is functioning normally.  

Table 7:    Fatal Error  

Error 
Code  

Meaning 

0x10 On module startup SPIOGA3 memory test failed.  

0x14  On module startup internal memory test failed.  

0x15 Internal error. 
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3.3.2  COMM LED 

The COMM LED indicates errors on the network. The following table provides a description of 
the status of the LEDs.  

Table 8:    COMM LED Status 

Color  Meaning 

Red  A network error has occurred. The LED flashes red at  
one-second intervals.  

Green  No network errors exist 

Flashing 
Green 

Token passing is occurring. 

If you are using the scanner as a passive DP Slave only, this LED will normally be off.  
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4 
Configuring and Programming the DP Master 

Chapter Sections: 

• Configuring the Scanner  

• Creating an I/O Configuration  

• Downloading to the Scanner 

• Troubleshooting 

• Importing the DP Master Binary Configuration (.bss) Using the SST PROFIBUS 
Configuration Tool 

• Uploading the I/O Configuration to the Scanner 

• Errors 

• Running the Scanner 

• Using the Watchdog Timer 
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4.1  Configuring the Scanner 

4.1.1  RS Logix 500 

 

Note 
When you are configuring the scanner, ensure that the SLC is in 
Program mode. 

1. Create a new program offline.  

2. Select the SLC processor, memory, and operating system.  

3. In the project tree, double-click on I/O Configuration.  

4. Set the size for rack 1.  

5. Highlight the SST-PB3-SLC slot.  

6. In the list of available modules, double-click on Other and enter the scanner ID code 
(13635).  

7. Highlight the scanner and click on Adv. Config.  

8. Set the M0 length and M1 length to 4200.  

9. If you are using fewer than 32 input words or 32 output words, you can change the 
scanned input and output words. You do not have to set the G File Length or set an 
Interrupt Service Routine number.  

10. Click OK to exit Advanced I/O Configuration.  

11. Close the I/O Configuration dialog box.  

12. Create the rest of your control program.  

13. Save the file and download it to the SLC. 
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4.2  Creating an I/O Configuration 
The SST PROFIBUS Configuration Tool window consists of a main or Network view and two 
panes: the PROFIBUS Devices pane (Device Library) and the On-line Browse pane (DP view). 
Both of these are floating panes; drag and drop them to move them anywhere inside the Network 
view.  
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Figure 5:   SST PROFIBUS Configuration Tool Window 

 

Configuring the SST-PB3-SLC Card as a DP Master  

1. Click the Windows  button. 

2. Navigate to the SST PROFIBUS Configuration option (located in your Start menu) to run 
the SST PROFIBUS Configuration Tool.  
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3. Select File>New to create a new configuration.  

• To open the Device library (left-most pane), select View>Library. This pane appears 
by default in the upper left-hand side of the window.  

• To open the On-line Browse pane or DP view, select View>On-line. This pane 
appears by default at the bottom of the window.  

4. Locate and select the SST-PB3-SLC Master device in the Device library  
(left-most pane).  

Figure 6:   SST-PB3-SLC Master Device 
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5. To add this Master device to the Network view:  

• Drag and drop it into the Network view.  

OR 

• Click on the Add to Network  icon on the main toolbar. A Configuration 
window displays for the selected device.  

Figure 7:   Device Configuration Window, General Tab 

 

6. Click the General tab.  

7. In the Station field, select the station number for the relevant Master.  

8. Select the COM Port tab.  
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Figure 8:   Device Configuration Window, COM Port Tab 
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9. From the Connection: field, select the COM port that you want to use to download the 
Master Configuration. 

10. Click OK. The Master device is added to the Network view (right-most pane).  

Figure 9:   Network View 

 

 

Note 
To edit device properties, right-click on the device and select Properties 
from the shortcut menu, or select the device from the Network view and 
select the Properties icon  on the main toolbar. 

11. Find and select your Slave device from the Device library. If your Slave device is  
not listed:  

a) In the Device library, click on the New Device icon  to add the GSD file for your 
device. The Add PROFIBUS Devices window opens. 

Figure 10:   Add PROFIBUS Devices Window 
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b) Locate the GSD file and click Open. 

 

Note 
A GS* file should have been supplied with your Slave device.  
If not, contact the vendor or search for it on the internet at:  

http://www.PROFIBUS.com/ 

* signifies the language 

The GSD file is added to the Device library (left-most pane).  

Figure 11:   Device Library 

 

http://www.profibus.com/


User Reference Guide  SST-PB3-SLC 

 

50  Configuring and Programming the DP Master 
©2011 Molex Inc.  

Document Edition: 1.2, Document #: 715-0104, Template Edition: 1.1, Template #: QMS-06-045 
Use, duplication or disclosure of this document or any of the information contained herein is subject to the restrictions on page ii of this document. 

12. You can now add the device to the Network view in one of two ways.  

• If you are connected to your PROFIBUS network, use the Online Browse feature to 
search for your Slaves on the network. For detailed information on how to perform 
this procedure, refer to Section 4.2.1, Online Browsing with DP View in the SST 
PROFIBUS Tool. 

• If you are not connected to your PROFIBUS network, you can do the following:  

• Drag and drop each Slave to the network view under the Master device.  

• Click on the Add to Network icon   on the main toolbar to display a 
configuration window for the selected Slave. This window displays the General 
tab, which is the default tab.  

Figure 12:   Configuration Window, General Tab 

 

13. In the Station field, set the slave’s station address. 
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14. Select the Modules tab.  

Figure 13:   Configuration Window, Modules Tab 

 
 

If your device is a modular device, you have to insert the modules that your Slave device 
uses. To do this, click the Add button to display the Add Modules window.  

Figure 14:   Add Modules Window 

 

If your Slave is not a modular device (compact device), then the modules are already 
configured. 

15. Select the module that you want the Slave to use.  

16. Click OK to set the module and return to the Slave Properties window.  
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17. Select the SLC Address tab and assign the input and/or output address(es).  

Figure 15:   Configuration Window, SLC Address Tab 

 

You have the option of using the default values that display as each module is 
highlighted, or of entering your own values.  

 

Note 
The software tries to make the best use of the available memory in the 
Input and Output files by packing the data. When modifying the offsets 
and using the M-files, you should avoid leaving large gaps between data 
blocks. 

 

 

Note 
You may now need to configure the Slave and module parameters. 
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18. Select the Ext. Prms tab (if it exists).  

Figure 16:   Configuration Window, Ext. Prms Tab 

 

You can also click the following buttons:  

• Edit - Allows you to change value of parameter. You can also double-click on a 
parameter to edit.  

• Hex - Displays parameters data in hex format  

• Details - Displays parameter characteristics  

• Offset - Parameter byte offset. The first parameter starts at offset 0.  

• Name - Parameter name  

• Value - Displays as text (where available) or a numeric value  

19. Configure any required parameters. You may now need to configure module parameters 
through the Modules tab. 
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20. Select the Modules tab.  

Figure 17:   Configuration Window, Modules Tab 

 

21. Select the module that needs parameterization and then Properties. The Data Area 
Properties window opens and displays the General tab.  

Figure 18:   Data Area Properties Window, General Tab 
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22. Select the Ext. Prms tab (if it exists) and set the parameters according to your device.  

Figure 19:   Data Area Properties Window, Ext. Prms Tab 

 

23. Click OK.  

24. Right-click on the highest level of the Network view (default is PROFIBUS_DP) and 
select Properties. The Network window displays (opens in General tab), allowing you to 
set the Baud Rate and other parameters found in the Timing and Parameters tabs.  

Figure 20:   Network Window, General Tab 

 
 



User Reference Guide  SST-PB3-SLC 

 

56  Configuring and Programming the DP Master 
©2011 Molex Inc.  

Document Edition: 1.2, Document #: 715-0104, Template Edition: 1.1, Template #: QMS-06-045 
Use, duplication or disclosure of this document or any of the information contained herein is subject to the restrictions on page ii of this document. 

25. Configure the following parameters according to your PROFIBUS network:  

• Name - Name of the network  

• Description - Description of the network  

• Baud Rate - Baud rate of the network  

• Highest Station - Highest allowed station address for any active station on the 
network. The highest station affects how much time is spent soliciting for new nodes.  

• Options - These affect the network parameters that the Configuration Tool assigns:  

• Repeater - indicates whether or not there are any repeaters on the network  

• FMS Devices - indicates whether or not there are any FMS devices on the 
network 

• Stay Off-line on Error - indicates whether or not the card stays off-line when the 
Token Error Limit or Response Error Limit is exceeded within 256 token cycles 

26. Click OK.  

27. Repeats steps 13-26 for each Slave device on your network. 

28. Select File>Save. The Save As window displays.  

Figure 21:   Save As Window 
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29. Specify a filename and location for your configuration and select Save. This saves your 
project as a .pbc file.  

30. To download your configuration, refer to Section 4.3, Downloading to the Scanner. 

31. You now have the option of exporting your configuration to a binary (.bss) file, using one 
of the following methods:  

• Select Edit/Export Binary... to export your configuration to a (.bss) file  

OR 

• Right-click on the SST-PB3-SLC Master and select the Export Binary... option.  

4.2.1  Online Browsing with DP View in the SST PROFIBUS Tool  

1. Verify that the SLC PLC is in Program mode.  

2. Connect the null modem cable between the scanner’s serial port and your PC COM port. 
Verify that you are connected to the PROFIBUS network.  

3. Select the Network Search Properties  icon. The DP View window displays.  

Figure 22:   DP View Window 
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4. Configure the network by specifying the following:  

• Local Card - Default radio button selection only. Select the Serial radio button.  

• Serial - Ensure that you select this radio button. This is the COM port to which your 
serial cable is connected.  

• Station - Set a station number not used by any of the Slaves on the network 

• Baud Rate - Slaves that do not support the selected baud rate will not be detected  

5. Click OK.  

6. When you are ready to browse, select the Search for Slave  icon. Slaves that have 
been detected display in station address order as shown: 

Figure 23:   List of Detected Slaves 
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7. Right-click on each Slave to assign its GSD file. A shortcut window displays with the 
following options:  

• GSD Files - Displays GSD file(s) found with corresponding Slave ID and a default 
generated GSD file, in case no ID match found.  

• Export GSD - Export a GSD file that will be saved with a new name, which by 
default is the station number Slave ID.  

• Edit GSD - Edit the selected GSD file. The generated GSD is the default; if it isn’t, 
select another GSD file. Here you are allowed to specify the vendor and model name, 
as well as Slave-specific options such as freeze, sync, auto baud, set Slave address, 
and user parameters.  

• Properties - Displays module information for that Slave  

 

Note 
To create a configuration with these Slaves, you must first have a Master 
in your configuration. You can then drag over the Slaves from the DP 
library to your Network view. 

8. Select the GSD File from the shortcut menu.  

Figure 24:   GSD File Selection 
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9. Drag and drop each Slave from the DP library to the Network view, below the Master. 
You may be prompted with the following window to select the correct I/O modules for 
the Slave.  

Figure 25:   Add Modules Window 

 

10. Click OK. The Slave is added and appears in your Network view. 

Figure 26:   Network View, Slave Added 
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11. Right-click on the Slave in your Network view.  

12. Select Properties from the shortcut menu. The Slave Properties window displays.  

Figure 27:   Slave Properties Window, General Tab 

 

13. Select the SLC Address tab and assign the I/O offset(s).  

Figure 28:   Slave Properties Window, Address Tab 
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You have the option of using the default values that display in the Offset fields, or of 
selecting each Configured Data Area and entering your own values.  

 

Note 
The software attempts to make the best use of the available memory in 
the Input and Output files by packing the data. When modifying the 
offsets and using the M files, you should avoid leaving large gaps 
between blocks of data. 

14. Select the Ext. Prms tab (if it exists).  

Figure 29:   Slave Properties Window, Ext. Prms Tab 

 

15. Configure any parameters that need to be set:  

• Edit - Allows you to change a parameter’s value. You can also double-click on a 
parameter to edit.  

• Hex - Displays parameters data in hex format 

• Details - Displays parameter characteristics 

• Offset - Parameter byte offset. The first parameter starts at offset 0.  

• Name - Parameter name  

• Value - Displays as text (where available) or a numeric value  
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You may now need to configure module parameters, via the Modules tab.  

16. Select OK.  

17. Repeat steps 8-15 until all of your Slaves are configured and exist under your Master in 
the Network View.  

18. Right-click on PROFIBUS-DP in Network view and select Properties from the shortcut 
menu. The Network window displays.  

Figure 30:   Network Window, General Tab 
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19. Configure the following parameters according to your PROFIBUS network:  

• Name - Name of the network.  

• Description - Description of the network.  

• Baud Rate - Baud rate of the PROFIBUS network.  

• Highest Station - Highest allowed station address for any active station on the 
network. The highest station affects how much time is spent soliciting for new nodes.  

• Options - These affect the network parameters that the Configuration Tool assigns: 

• Repeater - Indicates whether or not there are any repeaters on the network  

• FMS Devices - Indicates whether or not there are any FMS devices on the 
network.  

• Stay Off-line on Error - Indicates whether or not the card stays off-line when 
Token Error Limit or Response Error Limit is exceeded within 256 token cycles.  

20. Click OK. 

21. Select File>Save. The Save As window displays.  

Figure 31:   Save as Window 

 

22. Specify a filename and location for your configuration and select Save. This saves your 
project as a .pbc file.  
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4.3  Downloading to the Scanner  

4.3.1  Downloading the DP Master Configuration File to the Scanner 

Use the serial CONFIG port on the front of the scanner to download configuration files.  

The serial cable for a standard PC COM port must have lines 2 and 3 swapped. No handshaking 
is required. Pins 2 and 3 are wired the same as a PC 9-pin COM port.  

Figure 32:   Serial Port Wiring 

 
 

If you are using HyperTerminal, refer to Section 4.6  , Downloading the I/O Configuration to the 
Scanner Using HyperTerminal for detailed information. 
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4.3.2  Downloading to the Scanner via the SST PROFIBUS 
Configuration Tool  

1. Verify that the SLC PLC is in Program mode.  

2. Connect the modem serial cable between the PC COM port and the scanner serial port 
(top one).  

3. In your Master configuration, right-click on Master to display the shortcut menu.  

Figure 33:   Shortcut Menu 

 

4. Select Connect. You can also select the first icon  above PROFIBUS-DP *. If you 
do not have a mouse, select Connect from the Edit menu. 
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You may be prompted with a message indicating a configuration mismatch between what 
is in the scanner and your current PROFIBUS project. In this case, select Yes to retain 
your configuration.  

Figure 34:   Configuration Mismatch Dialog 

 

Any configuration mismatches are listed under the Master status.  

Figure 35:   List of Configuration Mismatches 
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5. Load the configuration to the Master via one of the following methods:  

• Right-click on the Master and select Load Configuration.  

Figure 36:   Shortcut Menu 

 

OR  

• Select the Load Configuration  icon in the toolbar. If the scanner is online, the 
following message displays: 

  —Card is online. Do you want to load configuration?  

6. Select Yes to load your new configuration. The Master status now changes to  
Configured Program mode.  

Figure 37:   Master Status of Configured Program 

 

Your scanner is now configured and ready.  
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4.3.3  Monitoring the Scanner via the SST PROFIBUS Configuration 
Tool  

1. Verify that the scanner is online by switching the SLC PLC to Run mode. Both the 
COMM (green) and SYS (red) LEDs should be ON.  

2. Right-click on the Master and select Connect from the shortcut menu.  

 

Note 
You may get a message indicating a configuration mismatch. Select YES 
to retain and download the configuration. 

3. Select the Online  icon in the toolbar. The Master should now display either:  

Figure 38:   Master Status OK 

 

OR  

Figure 39:   Master Status Error 

 

If this displays, refer to Section 4.3.5, Diagnosing Slave Errors in the SST PROFIBUS 
Configuration Tool. 
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4.3.4  Reconnecting to the Scanner that is Already Configured and 
Online  

1. Right-click on the Master and select Connect from the shortcut menu.  

 Note 
You may get a message indicating a configuration mismatch. Select YES  
to retain the configuration and download the configuration.  

2. Select the Online  icon in the toolbar. The Master should now display either: 

Figure 40:   Master Online, All OK 

 

OR  

Figure 41:   Master Online, Error 

 

If this displays, refer to Section 4.3.5, Diagnosing Slave Errors in the SST PROFIBUS 
Configuration Tool, for further information. 
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4.3.5  Diagnosing Slave Errors in the SST PROFIBUS Configuration 
Tool  

1. To diagnose Slaves in error (Red status), right-click on the Slave with the error.  

Figure 42:   Configuration Tool 

 

2. Select Diagnostics from the shortcut menu.  

Figure 43:   Shortcut menu 

 

A Slave Diagnostics window displays, indicating the errors specific to that Slave.  

Figure 44:   Slave Diagnostics Window 

 
 

3. Troubleshoot your Slave errors as required (refer to Section 4.4, Troubleshooting).  
Once you have verified that all errors have been corrected, right-click on the Master and 
select Disconnect.  
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4.4  Troubleshooting 
This section supplies troubleshooting details for messages that may be displayed during 
configuration or programming. 

Station Non-Existent  

Check the Slave PROFIBUS interface to ensure that it’s powered on and connected to your 
network. The Slave might not support the configured baud rate, which can happen when using 
the incorrect GSD file for a Slave.  

Configuration Data Fault  

Check that the I/O modules are configured in the order they appear in the Slave device and that 
they match the exact description of the modules you selected (i.e., module serial number).  

Station Not Ready  

This message will appear if there are outstanding errors, or if you are trying to scan the Slave too 
quickly. This may be caused by using a wrong GSD file.  

Extended Diagnostic Data  

This data is device specific. Retrieve it by requesting Slave diagnostics in your RSLogix 500 
program. Extended diagnostic data starts at byte 7 of the Slave diagnostics. Compare the values 
with descriptions that may be given for your Slave by viewing the Slave’s properties and 
selecting the Diagnostics tab in the SST PROFIBUS Configuration Tool.  

Function Not Supported  

The slave does not support commands such as Sync or Freeze coming from the Master.  
Check that you are using the correct GSD file.  

Invalid Slave Response  

This usually occurs when the Slave is returning more diagnostic information than the Master can 
handle. Check your GSD file.  
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Parameter Fault  

This usually means that an incorrect Indent - Number or Invalid parameter was sent to the Slave. 
Check that you have set the Slave parameters correctly by viewing the Slave’s properties and 
selecting the Ext. Prms tab. Also, view the module parameters by selecting the Modules tab 
under Slave properties, checking the module's properties and selecting the Ext. Prms tab.  

Master Lock  

The DP Slave has been parameterized by another Master. Put the controlling Master offline.  

Param/Config Required  

This message remains present until the parameterization has been completed properly. You may 
be using the incorrect GSD file or haven't set the Slave and module parameters to the correct 
values. These can be found under the Ext. Prms tab.  

Static Diagnostics  

Check your Slave diagnostic data in the scanner status area by writing the Slave station number 
to M1:x.3828.  The Slave diagnostics show up, starting at M1:x.3829.  

DP Slave Set  

This is OK and is set by the Slave.  

WatchDog  

This is OK and should be set when the Slave status is OK.  

Ext Diags Overflow  

More Diagnostic data is being returned from the Slave than what is specified in its GSD file.  
You may be using an incorrect GSD file.  
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4.5  Importing the DP Master Binary Configuration (.bss) 
Using the SST PROFIBUS Configuration Tool  
1. Select File>New. 

2. Select Edit>Import Binary from the menu. 

Figure 45:   Import Binary Command 

 

OR 

Select the Import Binary  icon from the toolbar. The Open window displays.  

Figure 46:   Open Window 

 
 



SST-PB3-SLC  User Reference Guide 

 

Configuring and Programming the DP Master  75 
©2011 Molex Inc.  

Document Edition: 1.2, Document #: 715-0104, Template Edition: 1.1, Template #: QMS-06-045 
Use, duplication or disclosure of this document or any of the information contained herein is subject to the restrictions on page ii of this document. 

3. Select and open your .Bss file. The Import Wizard displays.  

Figure 47:   Import Wizard 

 

4. From the dropdown menu, select SST-PB3-SLC.  

5. Select the Next> or Finish>> button. If you have multiple GSD files for the same Slave 
in your binary configuration, select the Next> button and follow the process to assign the 
correct GSD file.  

6. Select Finish>>.  

7. Select File>Save.  
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4.5.1  Uploading the DP Master Configuration File from the Scanner 
Using the SST PROFIBUS Configuration Tool  

1. Verify that the SLC PLC is in Program mode. 

2. Select File>New.  

3. Drag and drop the scanner from the Device Library (upper left-hand side) into the 
Network view. The Master Properties window displays.  

Figure 48:   Master Window, General Tab 

 

4. Select the COM Port tab.  

5. Specify the COMM port in the Connection field.  
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Figure 49:   Master Window, COM Port Tab 

 

6. Click OK.  

7. Right-click on the Master and select Connect from the shortcut menu.  

8. Select NO in response to the message “Do you want to ignore configuration?”. You may 
be prompted to go through the Configuration wizard to assign the correct GSD files.  

 

 

Note 
If the PROFIBUS module is online, in order to upload the actual offsets 
for the slave data, the configuration tool will prompt you to take the 
module offline. Otherwise default offsets will be used.  

 

9. Select Finish if you went through the Configuration wizard process. You can now save 
this uploaded configuration as a .pbc file.  

10. Select File>Save, assign a filename and location, and select Save.  

11. Right-click on the Master and select Disconnect from the shortcut menu.  
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4.6  Downloading the I/O Configuration to the Scanner Using 
HyperTerminal 

 

If you are using HyperTerminal, here is how to set up a connection: 

1. When configuring the scanner, the SLC must be in Program mode. 

2. Start HyperTerminal and create a new connection. 

3. Select 115 200 baud, with no parity, 8 data bits, 1 stop bit and no flow control. The 
scanner serial port supports any baud rate from 9600 to 115 200 baud, but 115 200 is the 
suggested rate. 

4. Type an asterisk (*) to get the scanner’s attention. You may need to type several asterisks 
to let the scanner auto-detect the baud rate being used. The scanner displays the following 
message, followed by a “>” prompt at the terminal:  

;Copyright (c) 1995-2009 WSE, a division of Molex. 
For SST-PB3-SLC Card 
Version x.xx 
 
Reading Configuration from FLASH... 

5. The scanner is now in CONFIG mode. While in CONFIG mode, the scanner LEDs are 
off. You can’t put the scanner online until you exit CONFIG mode. 

 

 

Note 
If the module has no configuration in flash, the following message is 
displayed in HyperTerminal: 
Error ‘30’ while Reading FLASH 
Don’t understand saved configuration… 
Clearing configuration 
pfbStnAddr = xxx 
 
Master Parameters Cleared 
Error ‘30’ while clearing FLASH 
 

Once a configuration is saved in flash, this error will no longer occur. 

 

6. To download a .bss DP Master configuration file, issue the RecBssXmodem command, 
then initiate an XModem file download from your communication software. Refer to the 
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documentation supplied with your Communication software for more detailed 
information. 

7. To download a .2bf DP Master configuration file, issue the Rec2bfXmodem command, 
then initiate an XModem file download from your communication software. 

8. Type Exit to end the Serial communication.  

9. If prompted with: 

  Configuration has changed. Do you want to UPDATE FLASH? (y/n)  

 Type “y” and press ENTER to accept. 

 

 

Note 
When you download a Configuration file to the scanner, the 
configuration is stored in memory on the scanner. Use the UpdFlash 
command to store the configuration into flash memory. 
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4.6.1  Listing Available Commands 

Once you are talking to the scanner, type Help at the terminal to view a summary of the 
available commands. Not all available commands are listed in the main Help. There are several 
additional Help commands to display the other ones.  

The following table lists commonly used serial port commands: 

Table 9:    Commonly Used Serial Port Commands 

Command  Function  

Ver Displays the version number of the firmware running on 
the scanner. 

Help Displays the general help screen. 

HelpNet  Lists commands to set network parameters.  

HelpMas  Lists commands related to DP Master operation.  

HelpSlv  Lists commands related to DP Slave operation. Refer to 
Chapter 7, Using the Scanner Module as a DP Slave, 
for more information.  

HelpMsg Lists the FDL message blocks configuration commands. 

HelpSAP Lists the FDL SAP configuration commands. 

ShowNet  Displays network parameters.  

ShowMas  Displays the DP Master configuration.  

ShowSlv  Displays the DP Slave configuration. Refer to Chapter 
7, Using the Scanner Module as a DP Slave, for more 
information. 

ShowMsg Displays the enabled/disabled status of FDL messaging. 

ShowSAP Displays the FDL SAP configuration. 

RecBssXmodem Receives a DP Master configuration exported as a 
binary file from the SST PROFIBUS Configuration Tool. 
Initiates the download of your DP Master Binary 
configuration exported from the Configuration Tool. 

Rec2bfXmodem  Uploads a DP Master configuration exported as a binary 
file from Siemens COM PROFIBUS.  

UpdFlash  Stores the current network and DP Master configuration 
into flash memory.  

Exit  Exits terminal mode and puts the module in Offline 
state.  
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4.7  Errors 

4.7.1  Network Parameter Errors 

The following status errors may occur when setting network parameters. Values are in 
hexadecimal. 

Table 10:    Network Parameter Errors 

Value Error Type  

02h  STS_BAD_BAUD  

03h  STS_BAD_STN_ADR  

04h  STS_BAD_HI_STN_ADR  

05h  STS_BAD_TOK_ROT  

06h  STS_BAD_SLOT_TME  

07h  STS_BAD_IDLE_1  

08h  STS_BAD_IDLE_2  

09h  STS_BAD_RDY_TME  

0ah  STS_BAD_QUI_TME  

0bh  STS_BAD_GAP_UPD  

0ch  STS_BAD_TOK_RETRY  

0dh  STS_BAD_MSG_RETRY  

0eh  STS_BAD_TOK_ERR_LIM  

0fh  STS_BAD_RSP_ERR_LIM  

10h  STS_BAUD_DET_ERROR  
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4.7.2  Binary File Configuration Errors 

The following errors occur when configuring the scanner using a binary file generated by your 
configuration software. 

Table 11:    Binary File Configuration Errors 

Value Error Type  

20h  STS_CFG_BAD_CHK_PATTERN  

21h  STS_CFG_BIN_TOO_SHORT  

22h  STS_CFG_BIN_TOO_LONG  

23h  STS_CFG_BAD_CHKSUM  

24h  STS_CFG_INVALID_CPU_HDR  

25h  STS_CFG_INVALID_SLV_REC_TYP  

26h  STS_CFG_RX_OVERFLOW  

27h  STS_CFG_TX_OVERFLOW  

35h  STS_CFG_MAS_EXT_ALLOC_ERROR  

• Error 20h occurs if you are using old firmware with the SST PROFIBUS Configuration 
Tool or firmware version 1.5x or later with the old Configuration Tool beta (ver 0.x).  

• Error 23h typically occurs when new firmware has just been loaded. Issue the ClrMas 
command and try downloading again.  

• Error 25h occurs when you use the incorrect command. Use Rec2bfXmodem for binary 
files from Siemens COM PROFIBUS and RecbssXmodem for binary files from the 
Configuration Tool. 
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4.7.3  Flash Programming Errors 

The following errors may occur when programming flash memory. 

Table 12:    Flash Programming Errors 

Value  Error Type  Meaning  

30h  STS_CFG_NO_CONFIG  No configuration present 
to program into flash.  

31h  STS_FLASH_BAD_ID  Internal flash error.  

32h  STS_FLASH_ERASE_ERR  Internal flash error.  

33h  STS_FLASH_PROG_ERR  Internal flash error.  

34h  STS_FLASH_VRFY_ERR  Internal flash error.  

4.7.4  COM PROFIBUS Address Assignment Errors 

Table 13:    COM PROFIBUS Address Assignment Errors 

Value Meaning 
37h  Address out of range. The address assigned in 

COM PROFIBUS is outside the allowed range; 
for example, P66.  

38h  Copy table overflow. This happens when I/O 
modules addresses are too fragmented. Try 
putting modules at consecutive addresses, 
grouping input and output modules, and so on.  
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4.7.5  Fatal Errors 

The following errors are fatal. You must power down the system and restart it to clear them 

Table 14:    Fatal Errors 

Value Error Type  Meaning 

80h  STS_CFG_INTERNAL_ERROR  Internal error.  

81h  STS_OUT_OF_APBS  Out of application blocks.  

82h  FATAL ERROR:pfb 
Status=82,errArg=00,interr=00  

The Host did not kick the 
watchdog within the 
watchdog period.  

83h  STS_HEAP_ALLOC_FAIL  Internal error.  

84h  STS_SH_HEAP_ALLOC_FAIL  Internal error.  

If the status register contains STS_CFG_INTERNAL_ERROR (80h), there has been an internal 
error on the scanner. Record the contents of the errInternal and errArg registers and contact 
Technical Support (for details, refer to Section C.3, Technical Support). ErrInt is stored in the 
high byte of register 4129 of the m1 file. ErrArg is stored in the low byte of register 4130 of the 
M1 file and also in register 4012 of the M1 file. 

Another way of notifying the user that a fatal error occurred is through the SYS LED blinking an 
8-bit error code (green for 1, red for 0), call Technical Support. This error reporting method is 
used when the severity of the error prevents the scanner from running and notifying the SLC 
accordingly.           

Table 15:    Fatal Errors Reported by SYS LED 

Code  Possible Reason  

10h  On startup, SLC ASIC memory test failure. 

14h  On startup, internal memory test failure.  

15h  Catastrophic internal failure. 
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4.8  Running the Scanner  
With the SLC in Run mode, the scanner scans the PROFIBUS I/O network. You can now begin 
accessing the data at the addresses that have been assigned in the Configuration Tool.  

4.8.1  SLC Modes  

The scanner’s mode of operation follows the SLC mode of operation (Program, Test, Run).  

• When the SLC is in Program mode, the scanner outputs are off and inputs hold their last 
state. 

• When the SLC is in Test mode, inputs are read and updated but outputs are off.  

• When the SLC is in Run mode, the scanner updates inputs and outputs. 

4.8.2  SLC Fault Codes  

The scanner may fault the SLC with one of the following error codes (x being the slot number of 
the slot occupied by the scanner).  

Table 16:    SLC Fault Codes 

Code  Possible Reason  

x61  Configuration faults. This happens when you try to go 
online with invalid configuration information.  

I/O faults. This can be caused by Slaves in error or 
by mismatches between the configured and actual 
Slave types. 
 

x62  This happens when you are in configuration mode 
(using the serial port to talk to the scanner) and try to 
put the SLC in RUN MODE.  

x70  Catastrophic internal failure. Call Technical Support.  
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4.8.3  Using the Watchdog Timer 

During a power “brown-out”, the AB SLC Processor can enter a reset condition, while the  
SST-PB3-SLC module remains fully functional. Although all SLC Scanner product installations 
should have adequate power conditioning and power failure equipment, brown-outs can still 
occur. To ensure that the SST-PB3-SLC returns the fieldbus to a known, safe state, a watchdog 
timer has been implemented in the firmware.  

4.8.4  How the Host Watchdog Works  

After the scanner has been reset or powered up, a default time of 1000 ms is used for the 
watchdog period, which exists for communications with the SLC Processor. If the scanner does 
not get an I/O update from the SLC processor within this timeframe, the scanner faults.  

The watchdog timer, may be set to a different value, in multiples of 10 milliseconds, by writing 
the contents of the S:3 work (from the SLC Processor‘s status file) to the M:0[slot].4011 register. 
The firmware takes the upper 8 bits of the S:3 word (the maximum scan time setting) and applies 
it as the new watchdog period. Your program can now control the scanner watchdog time and 
avoid any false faults that result from an extended processor scan time.  

Logic Example  

You can use the following rung of logic to automatically have the scanner’s watchdog period 
track that of the SLC processor.  

Figure 50:   Logic Example 

 

The SST-PB3-SLC is located in the first slot of the SLC rack. The watchdog register is 
M0:1.4011. 

 



SST-PB3-SLC  User Reference Guide 

 

DP Master Application Example  87 
©2011 Molex Inc.  

Document Edition: 1.2, Document #: 715-0104, Template Edition: 1.1, Template #: QMS-06-045 
Use, duplication or disclosure of this document or any of the information contained herein is subject to the restrictions on page ii of this document. 

5 
DP Master Application Example 

Chapter Sections 

• Example: Accessing Data 
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5.1  Example: Accessing Data 
The following example shows how to:  

• Use an internal SLC file to set up the Ignore Slave Status table (see Section 10.4,   
DP Master Slave Status Table) and copy it to the scanner on the first scan. Most users 
will not want to use the Global Fault Enable since they will not want the SLC CPU to 
fault on a Profibus fault. However, for those who need the card to behave in this manner, 
this example shows how. 

• Use a delay at startup to allow Slaves to go online before you configure the module to 
generate a fault, if any DP Slaves are faulted  

• Use internal SLC timers to distribute access to the M0 and M1 files over time to 
minimize the impact on the SLC logic scan  
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Figure 51:   Sample Program  

 

(Continued on following page). 
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(Figure 52, continued). 

 
 
 
 

 

The program uses 80 ms and 160 ms internal timers to implement four states, with a combined 
period of 320 ms. The OSR instructions ensure that the SLC executes the COP instruction only 
at the start of one of these states. The result is that all four blocks are accessed within the 320 ms 
combined period of the two timers.  
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6 
Using COM PROFIBUS with the  

SST-PB3-SLC Card 

Chapter Sections: 

• Addressing 

• 32 Discrete Output Module 

• 32 Discrete Input Module 

• Example: M0/M1 Addressing 

• Example: Using Flex I/O 

• Creating an I/O Configuration in COM PROFIBUS 
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6.1  Addressing 
The scanner occupies slot 2 in the SLC rack. The following table shows the modules in the I/O 
configuration, the address assigned in COM PROFIBUS, and the location of the I/O data in the 
SLC.  

Table 17:    Module Addresses 

Module  Address in COM PROFIBUS  Address in SLC  

32DO  P0  O:2.0 O:2.1  

8DO/DI  out P4  O:2.2 low byte  

 in P4  I:2.2 low byte  

32DI  P0  I:2.0 I:2.1  

8DO/24DI  out P6  O:2.3 low byte  

in P6  I:2.3 I:2.4 low byte  

6.2  32 Discrete Output Module  
The following table shows where the data appears in the SLC for a Siemens ET200B 32DO 
module mapped at different addresses in COM PROFIBUS (the scanner is in slot 2).  

Table 18:    Siemens ET200B Discrete Output Module Addresses 

Module Data 
Address 

Module Starting Address in COM PROFIBUS 

 P0 P1 Q0 Q1 

Q0.0 O:2.0/0 O:2.0/8 M0:2.0/0 M0:2.0/8 

Q0.7 O:2.0/7 O:2.0/15 M0:2.0/7 M0:2.0/15 

Q1.0 O:2.0/8 O:2.1/0 M0:2.0/8 M0:2.1/0 

Q1.7 O:2.0/15 O:2.1/7 M0:2.0/15 M0:2.1/7 

Q2.0 O:2.1/0 O:2.1/8 M0:2.1/0 M0:2.1/8 

Q2.7 O:2.1/7 O:2.1/15 M0:2.1/7 M0:2.1/15 

Q3.0 O:2.1/8 O:2.2/0 M0:2.1/8 M0:2.2/0 

Q3.7 O:2.1/15 O:2.2/7 M0:2.1/15 M0:2.2/7 
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6.3  32 Discrete Input Module  
The following table shows where the data appears in the SLC for a Siemens ET200B 32DI 
module mapped at different addresses in COM PROFIBUS (The scanner is in slot 2.).  

Table 19:    Siemens ET200B Discrete Output Module Addresses 

Module Data 
Address 

Module Starting Address in COM PROFIBUS 

 P0 P1 Q0 Q1 

I0.0  I:2.0/0 I:2.0/8 M1:2.0/0 M1:2.0/8 

I0.7  I:2.0/7 I:2.0/15 M1:2.0/7 M1:2.0/15 

I1.0  I:2.0/8 I:2.1/0 M1:2.0/8 M1:2.1/0 

I1.7  I:2.0/15 I:2.1/7 M1:2.0/15 M1:2.1/7 

I2.0  I:2.1/0 I:2.1/8 M1:2.1/0 M1:2.1/8 

I2.7  I:2.1/7 I:2.1/15 M1:2.1/7 M1:2.1/15 

I3.0  I:2.1/8 I:2.2/0 M1:2.1/8 M1:2.2/0 

I3.7  I:2.1/15 I:2.2/7 M1:2.1/15 M1:2.2/7 

6.4  Example: M0/M1 Addressing  
The scanner occupies slot 2 in the SLC rack. An 8DO/24DI module is assigned output address 
Q240 and input address Q250 in COM PROFIBUS. The output data is found at M0:2.120 low 
byte. The input data is found at M1:2.125 and M1:2.126 low byte. 

6.5  Example: Using Flex I/O  
When you configure the Flex I/O using COM PROFIBUS, always configure 18 slots, even if the 
slots are empty. The first two slots are used for status, with the first slot configured as an input 
word and the second slot as an output word. The remaining 16 slots are used for I/O modules. 
For each module, configure two slots.  

The following table shows how to configure the various Flex I/O modules. An entry of 000 
means “do not configure a length” for that slot.  

Configure the I/O address as a P address so that the data maps into the I or O file in the SLC for 
fast access, and the status part of the address as a Q address, so that the data maps into the M 
area.  
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Table 20:    Flex I/O Module Configurations 

Module  First Slot  Second Slot  

1794-IB16  1 word in  1 word out  

1794-OB16  000  1 word out  

1794-IB8S  1 word in  1 word out  

1794-IA8  1 word in  1 word out  

1794-OA8  000  1 word out  

1794-OW8  000  1 word out  

1794-IE8  9 words in  1 word out  

1794-OE4  1 word in  6 words out  

1794-IEX4OE2  5 words in  4 words out  

1794-IR8  11 words in  3 words out  

1203-FM1  6 words in  5 words out  

1794-IB16 full format  1 word in  000  

1794-OB16 full format  000  1 word out  

1794-IB8S full format  1 word in  000  

1794-IA8 full format  1 word in  000  

1794-OA8 full format  000  1 word out  

1794-OW8 full format  000  1 word out  

1794-IE8 full format  9 words in  000  

1794-OE4 full format  1 word in  4 words out  

1794-IEX4OE2 full format  5 words in  2 words out  

1794-IR8 full format  11 words in  000  

1203-FM1 full format  4 words in  3 words out  

Assign an address for each slot with a configured length.  
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In the following example, the first module is a 1794-IB16, the second is a 1794-OB16, and the 
third is a 1794-IE8. The scanner is in slot 2 of the SLC rack.  

Table 21:    Example of Module Input and Output Addressing 

Module  Slot  Assigned 
Type  

I Addr  O Addr  

Pre-assigned  0  1AI  Q0  - 
Pre-assigned  1  1AO  - Q2  

1794-IB16  2  1AI  P0  - 

 3  1AO  - Q4  

1794-OB16  4  000  - - 

 5  1AO  - P2  

1794-IE8  6  9AI  P4  - 

 7  1AO  - Q6  

Empty  8  000  - - 

 9  000  - - 

Empty  10  000  - - 

 11  000  - - 

Empty  12  000  - - 

 13  000  - - 

Empty  14  000  - - 

 15  000  - - 

Empty  16  000  - - 

 17  000  - - 

The input data for the 1794-IB16 maps into I:2/0 to I:2/15. The output data for the 1794-OB16 
module maps into O:2/16 to O:2/31. 
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6.6  Creating an I/O Configuration in COM PROFIBUS 
Use Siemens’s COM PROFIBUS software to configure a Master/Slave system on the  
SST-PB3-SLC.  

The COM PROFIBUS software does the following:  

• Calculates all the details for each Slave. For example, the configuration check data and 
the watchdog factors.  

• Calculates the details for the entire collection of Slaves. For example, the target token 
rotation time.  

• Assigns appropriate values for all the network parameters and includes them in the binary 
file  

To use the SST-PB3-SLC with COM PROFIBUS, install the update files for the SST-PB3-SLC 
in the appropriate COM PROFIBUS directories. These files can be downloaded from the 
www.molex.com website. 

http://www.woodhead.com/
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This procedure describes the steps to create a binary file for configuring the SST-PB3-SLC as a 
DP Master. In this procedure, the network being configured consists of only PROFIBUS DP 
remote I/O devices. For detailed information, refer to the COM PROFIBUS software 
documentation.  

1. Create a new file (File/New).  

2. Select the Master station number. This sets the scanner’s station number on the 
PROFIBUS network.  

3. For the Master station type, select SST-PB3-SLC Master. If the update files for the  
SST-PB3-SLC have not been installed, set the Master station type to be IM 308-C and  
the host type to S5-115U/ CPU 944A or S5-115U/CPU 944B.  

4. Select Configure/Bus parameters...  

• Set the baud rate for the network 

• If there is a repeater on the bus, check the Repeater on bus checkbox  

• If there are FMS devices on the network, change the Bus profile to DP/FMS  

• If the network has only PROFIBUS DP devices, leave the bus profile as PROFIBUS-
DP. COM PROFIBUS takes care of assigning appropriate default values for all the 
network parameters.  

5. Click OK.  

6. Select Configure/Slave parameters... to create and configure each Slave:  

• Select the Slave station number  

• Select the Slave device family  

• Select the Slave station type  

• Select the Slave module type 
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4. Click Configure... to assign the Slave’s I/O addresses. These determine where the Slave 
data appears in the SLC. For detailed information on addressing, refer to Section 6.6.1, 
Mapping the Addresses.  

5. After all the Slaves have been configured, select File>Save.  

6. Export the configuration to a binary file (File/Export/Binary File). This generates a  
.2bf file. 

 

Note 
If there are multiple Masters on the same network, include both Masters 
in the COM PROFIBUS file. Select the Master system to export and 
COM PROFIBUS will take care of increasing the target token rotation 
times, watchdog times, and so on, to appropriate values. 

 

 

Note 
The I/O addresses determine where the Slave data maps into the SLC 
data table. Siemens inputs P0 to P63 map into I0 to I31. Siemens outputs 
P0 to P63 map into O0 to O31. 
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6.6.1  Mapping the Addresses 

The addresses assigned in the Configuration Tool determine where the I/O data for the module 
appears in SLC memory. 

 

Note 
If you do not assign an address to a module, the data for that module will 
be unavailable. 

Addresses in the P range appear in the SLC’s I and O areas. Addresses P0 to P63 map to  
I0-31 for inputs and O0-31 for outputs. 

 

Note 
P addresses in the Configuration Tool are byte addresses, while I and O 
addresses in the SLC are word addresses. 

Addresses in the Q range appear in the M0 area (outputs) and the M1 area (inputs). Addresses 
Q0 to Q255 map to M1:0-127 for inputs and M0:0-127 for outputs. 

 

Note 
Q addresses in the Configuration Tool are byte addresses, while the 
SLC’s M0 and M1 addresses are word addresses. 

• For analog or word modules, assign addresses on even boundaries.  

• For 8-bit modules, if the address is even, the module occupies the low byte of the 
register. If the address is odd, it occupies the high byte.  

• Whenever possible, assign addresses so that everything maps into the I and O areas of 
memory. Accessing data in the M0 and M1 area slows the overall SLC scan. 
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7 
Using the Scanner Module as a DP Slave 

Chapter Sections: 

• Overview 

• Serial Port Setup 

• Using the Module as a DP Slave Only 

• Slave Received Data 

• Slave Transmit Data 

• Displaying the DP Slave Configuration 

• Saving the DP Slave Configuration to Flash 

• Disabling DP Slave Operation 

• Exiting Configuration Mode 
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7.1  Overview 
This chapter explains how to use the scanner module as a DP Slave.  

You can configure the scanner module to act as a DP Slave to another DP Master on the same 
network. For example, this feature can be used to pass data in a distributed system, or to/from  
an operator interface. The DP Slave operation can only be configured from the serial port. 

 

Note 
The scanner module does not check for address conflicts between the DP 
Master and DP Slave operations. You are responsible for ensuring that 
addresses have been assigned without conflicts or overlaps. 

If you are configuring the SST-PB3-SLC as a Master with its own 
Slaves, you must create the Master file separately.  

7.2  Serial Port Setup 
For a general description of the serial port settings, see Section 3.3.2, Serial Port Wiring. 

To set up the serial port, follow these steps: 

1. Start a HyperTerminal session. 

2. Set the baud rate to 115 200, 8 data bits, no parity, 1 stop bit and No Flow Control. 

3. Put the SLC into PROG mode and then type several asterisks, “*”.  

 

Note 
If you are using the SST-PB3-SLC as a DP Slave only, proceed to 
Section 7.3, Using the Module as a DP Slave Only. If you are using  
the card as both a DP Master and DP Slave, proceed to Section 7.4,  
Slave Received Data.  
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7.3  Using the Module as a DP Slave Only 
If you are using the scanner module s a DP Slave only, you’ll need to clear any DP Master 
configuration currently stored in the module. Issue the ClrMas command.  

Several network parameters must be set from the serial port before the module is put online.  
To begin, issue the ClrNet command to reset all network parameters to default. At a minimum, 
set the local station number and baud rate and make sure that the station is passive, not active. 
The module sets appropriate default values for the remaining network parameters.  

If the station is to be active, and if there are repeaters or FMS devices on the network, set the 
network options so that the module can set appropriate values for the network parameters. If the 
station is passive, most of them are not needed.  

7.3.1  Local Station  

To set the local station number, issue the LocStn command with the station number (0-125) as a 
parameter.  

Example  

LocStn 22 

7.3.2  Active/Passive  

To set the station to be passive, issue the Active 0 command. If you have issued the ClrMas 
command, this should already be 0. 

7.3.3  Baud Rate  

To set the baud rate, issue the Baud command with the baud rate as a parameter. Allowed values 
for this parameter are 9k6, 19k2, 31k25, 45k45, 93k75, 187k5, 500k, 750k, 1m5, 3m, 6m and 
12m.  

Example  

Issuing Baud 1m5 sets the baud rate to 1.5 Mbaud.  
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7.3.4  Other Network Options  

• To tell the module that there are one or more repeaters on the network, issue the 
Repeater 1 command from the serial port.  

• To tell the module that there are FMS devices on the network, issue the FmsDevices 1 
command from the serial port.  

7.3.5  Displaying Network Settings  

To display the current network parameter settings, issue the ShowNet command from the serial 
port.  
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7.4  Slave Received Data  
Received data is data received from the remote Master. It has the following capabilities: 

• From 0 to 122 words  

• The data can be configured to be partly in the input file and partly in the M1 file  

• Up to 32 words can be put in the input file  

• All received data can be put in the M1 file, if desired  

• Data in the input file can be accessed more quickly than data in the M1 file, but the more 
DP Slave data you put in the input file, the less input data you can scan with the module 
acting as a DP Master  

In the M1 file, DP Slave received data always starts at offset 1000. To set the received data 
length and location, use the SlvRxLen command, using the following three parameters: 

• <io>: the offset of the received data in the input file (0-31) 

• <il>: the length of received data in the input file (0-32) 

• <ml>: the length of received data in the M1 file (0-122) 

The format of the command would be:  

SlvRxLen <io> <il> <ml> 

Example  

If you enter SlvRxLen 30 2 10, there will be two words of received data in the input file, 
starting at offset 30, and ten words of received data in the M1 file, starting at offset 1000. There 
are a total of 12 words of received data.  
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7.5  Slave Transmit Data  
Transmit data is the data the scanner module sends to the remote Master. It has the following 
capabilities: 

• From 0 to 122 words of transmit data 

• The data can be configured to be partly in the output file and partly in the M0 file 

• Up to 32 words of transmit data can be placed in the output file.  

• Data in the output file can be accessed more quickly than data in the M0 file, but the 
more DP Slave data you put in the output file, the less output data you can scan with the 
module acting as a DP Master.  

Transmit data in the M0 file always starts at offset 1000. To set the transmit data length and 
location, use the SlvTxLen command, using the following three parameters: 

• <oo>: the offset of the transmit data in the output file (0-31) 

• <ol>: the length of transmit data in the output file (0-32) 

• <ml>: the length of transmit data in the M0 file (0-122) 

The format of the command would be: 

SlvTxLen <oo> <ol> <ml> 

Example 

If you enter SlvTxLen 31 1 100, there will be one word of transmit data in the output file, 
starting at offset 31, and one hundred words of transmit data in the M0 file, starting at offset 
1000. There are a total of 101 words of transmit data.  
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7.6  Displaying the DP Slave Configuration  
If you issue the ShowSlv command from the serial port, the module displays the DP Slave 
configuration.  

Example  

If you use the ShowSlv command after issuing the configuration commands in the previous 
examples, the scanner displays:  

DP Slave Configuration:  

SlvTxLen O:x.31 Len=1 M0:x.1000 Len=100  
SlvRxLen I:x.30 Len=2 M1:x.1000 Len=10  

7.7  Saving the DP Slave Configuration to Flash 
Once you are satisfied with the DP Slave Configuration, issue the UpdFlash command to save 
the configuration to flash memory. 

7.8  Disabling DP Slave Operation  
To clear the DP Slave configuration data and disable DP Slave operation, issue the ClrSlv 
command from the serial port.  

7.9  Exiting Configuration Mode 
Once you have finished all of your configurations, issue the exit command to exit Configuration 
Mode.  
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8 
Using FDL 

Chapter Sections: 

• FDL (Layer 2) Messaging 

• FDL Messages 

• FDL SAPs 

• FDL Diagnostic Counters 

• FDL Network Parameters 
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8.1  FDL (Layer 2) Messaging  
The SST-PB3-SLC can send and receive FDL (layer 2) messages. Features include:  

• Support for up to 4 Service Access Points (SAPs)  

• Support for up to 4 message request blocks  

Messages and SAPs are enabled from the serial port and any required configuration is done from 
the SLC. 

 Caution 
If you are using FDL, the scanner uses words I:31 and O:31 in the I/O 
tables for FDL control and status. You must not configure any I/O 
modules to use these words, or unpredictable operation will occur. 

The scanner sets the bits in the input file; the SLC application sets the bits in the output file. 

8.1.1  Input Table I:31  

The scanner uses the following bits in the input word:  

Table 22:    Input Word Offsets 

Message/SAP Block (0-3) Bit Offsets 

SAP indication update  0 1 2 3 

Message done  8 9 10 11 

Message error  12 13 14 15 

The subsequent sections explain how these bits are used.  
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8.1.2  Output Table O:31  

The SLC application uses the following bits in the output word:  

Table 23:    Output Word Offsets 

Message/SAP Block (0-3) Bit Offsets 

SAP indication 
acknowledge  

0 1 2 3 

Message trigger  8 9 10 11 

The subsequent sections explain how these bits are used.  

8.1.3  M0 and M1 Files  

The scanner uses areas in the M0 and M1 files for FDL message and SAP configuration 
information and data.  

Table 24:    M0 Offsets 

M0 Offsets  Use  

1122-1251  FDL message control/Tx buffer 0  

1252-1381  FDL message control/Tx buffer 1  

1382-1511  FDL message control/Tx buffer 2  

1512-1641  FDL message control/Tx buffer 3  

1642-1771  FDL SAP Tx buffer 0  

1772-1901  FDL SAP Tx buffer 1  

1902-2031  FDL SAP Tx buffer 2  

2032-2161  FDL SAP Tx buffer 3  
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Table 25:    M1 Offsets 

M1 Offsets  Use  

1122-1251  FDL message status/Rx buffer 0  

1252-1381  FDL message status/Rx buffer 1  

1382-1511  FDL message status/Rx buffer 2  

1512-1641  FDL message status/Rx buffer 3  

1642-1771  FDL SAP Status/Rx buffer 0  

1772-1901  FDL SAP Status/Rx buffer 1  

1902-2031  FDL SAP Status/Rx buffer 2  

2032-2161  FDL SAP Status/Rx buffer 3  

8.2  FDL Messages  
To enable FDL messages, issue the EnaMsg command from the serial port while in 
configuration mode and talking to the scanner. The state of FDL messages (enabled/disabled)  
is stored in flash when you exit configuration mode.  

8.2.1  Setting up a Message  

To set up a message block, select which message block (0-3) is being used. This determines 
which of the areas in the M0 and M1 files will be used.  

In the corresponding area of the M0 file, set the appropriate values in the FDL message control 
block for the message. 
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The following table shows the offsets to the message control block elements for each of the four 
message control blocks (0-3), and their locations in the M0 file.  

Table 26:    Message Control Block Offsets 

Offset Name 0 1 2 3 

0 CntCfg 1122 1252 1382 1512 

1 reserved 1123 1253 1383 1513 

2 reserved 1124 1254 1384 1514 

3 DstStn 1125 1255 1385 1515 

4 DstSap 1126 1256 1386 1516 

5 SrcSap 1127 1257 1387 1517 

6 FrmCntrl 1128 1258 1388 1518 

7 TxLen 1129 1259 1389 1519 

8-129 TxData 1130-1251 1260-1381 1390-1511 1520-1641 

To set up a message, set:  

• Bits in the Control/Config register, CntCfg, if necessary.  

If you set bit 2, the scanner sends the message to its high priority queue. The scanner 
maintains two FDL message queues: high priority, and low priority. The scanner can 
send one message from the high priority queue when it gets the token, even if the token 
hold time has expired.  

 

Note 
In this case, high priority refers to how the message is processed by the scanner 
in getting it out on the network; it has nothing to do with a high- priority frame 
control value. For example, if the message type is SRDL, the message is 
processed as low-priority at the destination. 

If you set bit 4 in the CntCfg register, the scanner does not include this message block 
when it is displaying the status of FDL messages on the LED.  

• The destination station, DstStn. The allowed range is 0 to 126.  
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• The destination SAP, DstSap, if required. This is almost always needed. The default 
value is 255, which means the message gets sent to the default SAP at the destination. 
You usually send the message to some specific SAP. The allowed range is 0 to 63, or 
255.  

When you send a message with a destination SAP, the scanner automatically sets the high 
bit in the destination station number. Do not set the high bit when you set the destination 
station number.  

• The source SAP, SrcSap, if required. If you are sending a destination SAP, you almost 
always want to send a source SAP. The default value is 255. The use of the source SAP is 
application and module dependent; the destination station may or may not require or use 
the source SAP.  

• The message type, or frame control, FrmCntrl. The message type can be one of the 
following:  

Table 27:    Message Types 

Message Type Address Function/Description 

FC_SDAl  03h  Send Data with Ack Lo Pri (SDAL)  

FC_SDAh  05h  Send Data with Ack Hi Pri (SDAH)  

FC_SDNl  04h  Send Data No Ack Lo Pri (SDNL)  

FC_SDNh  06h  Send Data No Ack Hi Pri (SDNH)  

FC_SRDl  0Ch  Send and Request Data Lo Pri (SRDL)  

FC_SRDh  0Dh  Send and Request Data Hi Pri (SRDH)  

FC_SmTime1  00h  First SM time message  

FC_SmTime2  80h  Second SM time message  

FC_SmSDN  02h  SM Send Data No ack  

FC_SmSRD  01h  SM Send and Request Data  

FC_SmSRDSltDel  0Ah  SM Send and Request Data Slot Del  

FC_SmSRDSltKee 
p  

0Bh  SM Send and Request Data Slot Keep  

FC_DdbSRD  07h  DDB Send and Request Data  

FC_DiagSRD  08h  Diagnosis Send and Request Data  

FC_ReqFDL  09h  Request FDL status  

FC_ReqId  0Eh  Request ID  

FC_ReqLSAPSts  0Fh  Request LSAP Status  
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• The transmit data length, TxLen, in bytes. The allowed values are 0 to 244.  

• The transmit data, TxData 

8.2.2  Sending the Message  

To send the message, set the appropriate trigger bit in word O:31 of the output file for the 
message block.  

Table 28:    Message Trigger Offsets 

Message/SAP Block (0-3) Bit Offsets 

Message block  0 1 2 3 

Message trigger  8 9 10 11 

The scanner sends the message. Wait for the Message Done bit to be set and check the error bit 
in word I:31 of the input file.  

Table 29:    Message Done Offsets 

Message/SAP Block (0-3) Bit Offsets 

Message block  0 1 2 3 

Message done  8 9 10 11 

Message error  12 13 14 15 

If there is an error with the message, both the done bit and the error bit will be set.  
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8.2.3  Message Replies  

The scanner module always fills in the message reply area in the M1 file. Some of the data 
comes from the destination station; some comes from the scanner.  

Table 30:    Message Reply Offsets 

Offset Name 0 1 2 3 

0 Reserved 1122 1252 1382 1512 

1 Status 1123 1253 1383 1513 

2 Error 1124 1254 1384 1514 

3 Reserved 1125 1255 1385 1515 

4 RspStatus 1126 1256 1386 1516 

5 Reserved 1127 1257 1387 1517 

6 Reserved 1128 1258 1388 1518 

7 RxLen 1129 1259 1389 1519 

8-129 RxData 1130-1251 1260-1381 1390-1511 1520-1641 

• If the message has good status, Status will have bit 7 set 

• If the scanner could not deliver the message, the value in Error is 1. For more information 
on the cause, look in RspStatus.  

• If the transmit length was greater than 244, the value in Error is 3. 



SST-PB3-SLC  User Reference Guide 

 

Using FDL  117 
©2011 Molex Inc.  

Document Edition: 1.2, Document #: 715-0104, Template Edition: 1.1, Template #: QMS-06-045 
Use, duplication or disclosure of this document or any of the information contained herein is subject to the restrictions on page ii of this document. 

RspStatus contains the value returned by the LAN controller when it encounters an error. Mask 
the value with BFh and use the following table to determine the meaning. X indicates “do not 
care” values in the upper half of the byte.  

Table 31:    Message Reply Values 

Value, hex  Meaning  

X0  OK  

X1  User error. SAP locked. The destination station did not 
accept the message because the SAP was locked.  

X2  No resource for send data. The SAP could not accept the 
message. For example, this happens when the SAP‘s 
receive buffer is too small.  

X3  No service available (destination SAP doesn‘t exist, or when 
strict frame control checking is enabled on the destination 
station, and there‘s a mismatch)  

X4  Access point blocked.  

80  Short character, problems with wiring, termination, etc.  

9F  No access. The destination station isn’t available.  

AF  Double token detected, problems with wiring, termination, 
etc.  

BF  Response buffer too small.  

8F  Noise at SM command, problems with wiring, termination, 
etc.  

If the destination station sends reply data, the reply data length in bytes is in RxLen. Possible 
values are 0 to 244. The reply data itself is found in RxData.  
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8.2.4  Sending Broadcast and Multicast Messages  

Broadcast and multicast messages are sent to destination station 127. Broadcast messages are 
sent to destination SAP 63. The frame control must be SDNl or SDNh, as all broadcast/multicast 
messages are unconfirmed.  

In order for the destination station to receive a broadcast or multicast message, it must have strict 
station checking disabled. To receive a broadcast message, it must have a SAP configured on 
SAP 63.  

Figure 52:   FDL SAP Message Send Handshake Example 

 
 

(Continued on following page). 
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(Figure 53, continued). 
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8.3  FDL SAPs  
You can enable up to four Service Access Points (SAPs) on the scanner. You enable SAPs from 
the serial port, using the SAPBlk command. The syntax is SAPBlk <blk> <sap>, where <blk>  
is the block number, from 0 to 3, and <sap> is the SAP number, from 0 to 63. 

To disable all SAPs, use the ClrSap command. SAPs are used to receive FDL messages  
from remote stations. When the scanner receives an update on a configured SAP, it sets the 
corresponding bit in input word I:31 and sends reply data, if you have set it up.  

Table 32:    SAP Indication Update Offsets 

Message/SAP Block (0-3) Bit Offsets 

SAP block  0 1 2 3 

SAP indication update  0 1 2 3 

To acknowledge the SAP update, set the corresponding bit in output word O:31.  

Table 33:    SAP Indication Acknowledge Offsets 

Message/SAP Block (0-3) Bit Offsets 

SAP block  0 1 2 3 

SAP indication ACK  0 1 2 3 

Setting the SAP indication ACK bit tells the scanner to clear the SAP indication update bit in  
the input word and transfers the current reply data from the area in the M0 file for this SAP block 
to the area the scanner uses to send a reply the next time the SAP is updated.  

 

Note 
The scanner automatically sends the reply data when the SAP is 
updated. In order for the scanner to have reply data ready when the SAP 
is first updated, you must set the SAP indication ACK bit for the SAP 
block when your program starts. 

When the scanner clears the SAP indication update bit in the input word, your application should 
clear the SAP indication acknowledge bit.  
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8.3.1  SAP Receive Buffers  

Whenever an SAP is updated, the scanner fills in the appropriate receive buffer in the M1 file. 
Some of the data comes from the source station; some comes from the scanner.  

Table 34:     SAP Receive Buffer Offsets 

Offset Name 0 1 2 3 

0 Reserved 1642 1772 1902 2032 

1 Status 1643 1773 1903 2033 

2 Error 1644 1774 1904 2034 

3 Reserved 1645 1775 1905 2035 

4 SrcStn 1646 1776 1906 2036 

5 SrcSap 1647 1777 1907 2037 

6 Reserved 1648 1778 1908 2038 

7 RxLen 1649 1779 1909 2039 

8-129 RxData 1650-1771 1780-1901 1910-2031 2040-2161 

• Bit 7 in Status is set if the SAP is operating with no problems. If this bit is 0, there is a 
problem with this SAP, and Error contains the value 1.  

• SrcStn contains the number of the station that updated the SAP  

• Bit 7 is set if the message was sent with a source SAP 

• SrcSap is the source SAP sent in the message and is valid only if bit 7 in SrcStn is set 

• RxLen is the length of received data, in bytes. Possible values are 0 to 244. 

• RxData contains the received data 
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8.3.2  SAP Transmit Buffers  

If you are sending reply data, you must set up an FDL transmit buffer in the M0 file.  

Table 35:    SAP Transmit Buffer Offsets 

Offset Name 0 1 2 3 

0-6 reserved 1642-1648 1772-1778 1902-1908 2032-2038 

7 TxLen 1649 1779 1909 2039 

8-129 TxData 1650-1771 1780-1901 1910-2031 2040-2161 

Write the transmit length, in bytes, to TxLen, and write the transmit data in TxData.  

 

Note 
The scanner automatically sends the reply data when the SAP is 
updated. In order for the scanner to have reply data ready when the SAP 
is first updated, you must set the SAP indication ACK bit for the SAP 
block when your program starts. 
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8.3.3  Receiving Broadcast/Multicast Messages  

To receive broadcast messages, you must have an SAP configured on SAP number 63.  
To receive a multicast message, you must have an SAP configured to match what the sender is 
using.  

Figure 53:   FDL SAP Message Receipt Handshake Example 

 
 
 

(Continued on following page). 
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(Figure 54, continued). 
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8.4  FDL Diagnostic Counters  
The scanner maintains several diagnostic counters for FDL operation.  

Table 36:    FDL Diagnostic Counters 

Name  Location Meaning 

diagLay2MsgOk  4116 FDL messages sent OK. The scanner 
increments diagLay2MsgOk whenever it 
sends an FDL message and receives the 
appropriate acknowledge or response 
data. 

errLay2MsgNotOk  4117L FDL message errors. The scanner 
increments errLay2MsgNotOk whenever it 
sends an FDL message and doesn’t 
receive appropriate acknowledge or 
response data.   

diagLay2SapOk  4118 FDL SAP requests processed OK. The 
scanner increments diagLay2SapOk when 
it processes an FDL SAP request with no 
errors.   

errLay2SapNotOk  4119L FDL SAP errors. The scanner increments 
errLay2SapNotOk when there is an error 
receiving an SAP request.   
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8.5  FDL Network Parameters  
If you are using the scanner only for FDL, you must also set several network parameters from the 
serial port before putting the module online. At a minimum, set the local station number and the 
baud rate. If you are sending FDL messages, make sure that the station is active. The station does 
not have to be active to send replies to SAP updates. The scanner sets appropriate default values 
for the remaining network parameters.  

If the station is to be active, and if there are repeaters or FMS devices on the network, set the 
network options so that the scanner can set appropriate values for the network parameters.  
Most of them are not needed if the station is passive.  

You may also want to change the high station address to optimize performance. The default high 
station address is 126.  

8.5.1  Local Station  

To set the local station number, issue the LocStn command with the station number (0-126) as a 
parameter.  

Example  

LocStn 22 

8.5.2  Active/Passive  

To set the station to be active, issue the Active 1 command.  
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8.5.3  Baud Rate  

To set the baud rate, issue the Baud command with the baud rate as a parameter. Allowed values 
for this parameter are 9k6, 19k2, 31k25, 45k45, 93k75, 187k5, 500k, 750k, 1m5, 3m, 6m and 
12m.  

Example  

Baud 1m5 sets the baud rate to 1.5 Mbaud.  

8.5.4  Other Network Options  

To tell the module that there are one or more repeaters on the network, issue the Repeater 1 
command from the serial port.  

To tell the module that there are FMS devices on the network, issue the FmsDevices 1 command 
from the serial port.  

8.5.5  Displaying Network Settings  

To display the current network parameter settings, issue the ShowNet command from the serial 
port.  
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9 
DPV1 Master Functionality 

Chapter Sections: 

• Overview 

• DPV1-Supported Functions 

• DPV1 Command Description 

• DPV1 Sample Code 
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9.1  Overview 
The SST-PB3-SLC can act on a PROFIBUS network as a DPV1 Class 1 & Class 2 master. The 
DPV1 module is able to: 

• Send DPV1 Class 1 and Class 2 commands 

• Manage up to 32 simultaneous Class 2 connections 

 

9.2  DPV1-Supported Functions 
The following table lists the supported DPV1 functions. 

Table 37:    Supported DPV1 Functions 

Supported DPV1 Functions  Service  

MSAC1_Read  0x52  

MSAC1_Write  0x53  

MSAC2_Initiate  0x54  

MSAC2_Idle  0x58  

MSAC2_Abort  0x55  

MSAC2_Read  0x56  

MSAC2_Write  0x57  

 

9.3  DPV1 Command Description 
The backplane CPU can send DPV1 commands to slaves through the scanner. The scanner uses 
areas in the M0 and M1 files for DPV1 message configuration. The scanner writes to the M1 file; 
the SLC application writes to the M0 file.  

9.3.1  DPV1 Message Configuration 

The scanner uses the following areas in the M0 and M1 files. 

Table 38:    M0 Message Configuration 

M0 Offset  Use 

2162  Transaction number  

2163 DPV1 service code 

2164-2299 DPV1 transmit data 
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Table 39:    M1 Message Configuration 

M0 Offset  Use 

2162  Transaction number  

2163 Received data length 

2164 Status – error code 

2165-2166 Extended error code 

2167-2302 DPV1 received data 

 

The SLC application sets the transaction number in the M0 file to indicate to the module that a 
new message request is available. The scanner processes the request and it sets the transaction 
number in the M1 file to the same value as read from M0. The SLC application should read the 
reply from M1 only when the two transaction numbers are identical. The scanner does not 
process another transaction until the transaction number in M0 differs from the one in M1. At 
startup the transaction number in M1 is 0 and the scanner expects a non zero value for the 
transaction number in M0, before processing the first message. 

9.3.2  DPV1 Init Command 

This command, service code 0x50, initializes DPV1 functionality on the scanner. One block 
corresponds to one DPV1 frame on the PROFIBUS network. This command should be called in 
offline mode, therefore the SLC application must send it within the first scan, before the module 
is put online. 

 

  

Note 
If the scanner is online prior to issuing the Run command (when using 
the Configuration Tool, for example) and the SLC application initiates 
DPV1 messaging, ensure the module is taken offline before going to 
Run mode. 

 

Table 40:    Request Format 

Tx Offset  Use 

0  Number of blocks required [1…32]  

Table 41:    Reply Format 

Rx Offset  Use 
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0  Number of blocks allocated [1…32]  

Table 42:    Error Codes 

Value  General Status  
00h  Successful  

E1h  Unknown command  

E2h  Invalid command data length  

E8h  Resources unavailable  

EDh  DPV1 already initialized  

EEh  Invalid number of bloc requested  

F0h  Offline state expected  

9.3.3  DPV1 Exit Command 

This command, service code 0x51, stops DPV1 functionality in the scanner.  

Request Format: None 

Reply Format: None 

Table 43:    Error Codes 

Value  General Status  
00h  Successful  

E1h  Unknown command  

E2h  Invalid command data length  

EFh  DPV1 is not initialized  

9.3.4  DPV1 Class 1 Read Command 

This command, service code 0x52, reads data from a DPV1 slave using Slot_Number and Index 
parameters. 

Table 44:    Request Format 

Tx Offset  Use 

0-3  Command timeout  

4 Slave address [0…126] 

5 Slot number where the data should be read [0…254] 

6 Index where the data should be read [0…254] 

7 Number of bytes to read [1…240] 

Table 45:    Reply Format 

Rx Offset  Use 
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0-239  Data read (size, 1-240 bytes)  

Table 46:    Error Codes 

Value  General Status  
00h  Successful  

E1h  Unknown command  

E2h  Invalid command data length  

E5h FDL error (see extended error code) 

E6h DPV1 error (see extended error code) 

E7h  Another command is already in progress for this slave / 
class 2 connection.  

EAh  Invalid remote address  

ECh  Invalid data length  

EFh  DPV1 is not initialized  

F1h  Online state expected  

F3h  Invalid slave response  

F6h  No space left on command queue  

F7h Command Timeout 

9.3.5  DPV1 Class Write Command 

This command, service code 0x53, writes data to a DPV1 slave using Slot_Number and Index 
parameters. 

Table 47:    Request Format 

Tx Offset  Use 

0-3  Command timeout  

4 Slave address [0…126] 

5 Slot number where the data should be written 
[0…254] 

6 Index where the data should be written [0…254] 

7 Number of bytes to write [1…240] 

8-247 Data to be written (size, 1-240 bytes) 

Table 48:    Reply Format 

Rx Offset  Use 

0 Number of bytes written [1…240]  

Table 49:    Error Codes 

Value  General Status  
00h  Successful  

E1h  Unknown command  

E2h  Invalid command data length  
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E5h FDL error (see extended error code) 

E6h DPV1 error (see extended error code) 

E7h  Another command is already in progress for this slave / 
class 2 connection.  

EAh  Invalid remote address  

ECh  Invalid data length  

EFh  DPV1 is not initialized  

F1h  Online state expected  

F3h  Invalid slave response  

F6h  No space left on command queue  

F7h Command Timeout 

9.3.6  DPV1 Initiate Command 

This command, service code 0x54, initiates a DPV1 Class 2 connection to a slave.  

 

Note 
When using Class 2 communication, up to 32 connections can be 
initiated. 

Table 50:    Request Format 

Tx Offset  Use 

0-3  Time allowed for message reply in ms  

4 Slave address [0…126] 

5-6 Time expected in 10 ms 

7-8 Features supported by the master 

11-12 Desired profile ID number (0 = no profile) 

 Subnet parameters 

13 STYPE: 0 or 1; if STYPE = 1 the optional Net_addr 
and Mac_addr is present in S_Addr. 

14 S_Addr_Len: Length of the S_Addr :  
if STYPE = 0, the S_Addr_Len = 2  
if STYPE = 1, the S_Addr_Len = 8 + length of 
Mac_addr (x)  

15 DTYPE: 0 or 1; if DTYPE = 1 the optional Net_addr 
and Mac_addr is present in D_Addr.  

16 D_Addr_Len: Length of the D_Addr :  
if DTYPE = 0, the D_Addr_Len = 2  
if DTYPE = 1, the D_Addr_Len = 8 + length of 
Mac_addr (y)  

 S_Addr 

17 Application process instance 

18 Access level 

19-24 Network address according to ISO/OSI Network 
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addresses 

25-(25+x-1) MAC Address 

 D_Addr 

25+x Application process instance 

26+x Access level 

(27+x)-(33+x-1) Network address according to ISO/OSI Network 
addresses 

(33+x)-(33+x+y-1) MAC Address 

Table 51:    Reply Format 

Rx Offset  Use 

0 Connection reference  

1-2 Updated time by the slave in 10 ms units (high byte 
first) 

3-4 Features supported by the slave (high byte first) 

5-6 Service functionality supported by the slave (high 
byte first) 

7-8 Profile ID supported by the slave (high byte first) 

Table 52:    Error Codes 

Value  General Status  
00h  Successful  

E1h  Unknown command  

E2h  Invalid command data length  

E5h FDL error (see extended error code) 

E6h DPV1 error (see extended error code) 

E7h  Another command is already in progress for this slave / 
class 2 connection.  

EAh  Invalid remote address  

EFh  DPV1 is not initialized  

F1h  Online state expected  

F2h  Invalid Add_Addr parameter  

F3h  Invalid slave response  

F4h  Could not manage more Class 2 connections  

F6h  No space left on command queue  

F7h Command Timeout 

9.3.7  DPV1 Class 2 Abort Command 

This command, service code 0x55, aborts a DPV1 Class 2 connection. 

Table 53:    Request Format 

Tx Offset  Use 

0-3  Reserved  
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4 Connection reference returned by initiate 

5 Location of the source of the abort request (0) 

6 Protocol instance and reason for the abort (2) 

Reply Format: None 

Table 54:    Error Codes 

Value  General Status  
00h  Successful  

E1h  Unknown command  

E2h  Invalid command data length  

E7h  Another command is already in progress for this slave / 
class 2 connection.  

EBh  Invalid connection reference  

EFh  DPV1 is not initialized  

F1h  Online state expected  

F5h  Class 2 connection is not initialized  

F6h  No space left on command queue  

F7h Command Timeout 

9.3.8  DPV1 Class 2 Read Command 

This command, service code 0x56, reads data from a DPV1 slave using Slot_Number and Index 
parameters through a Class 2 connection. 

Table 55:    Request Format 

Tx Offset  Use 

0-3  Command timeout  

4 Connection reference 

5 Slot number where the data should be read [0…254] 

6 Index where the data should be read [0…254] 

7 Number of bytes to read [1…240] 

Table 56:    Reply Format 

Rx Offset  Use 

0-239  Data read (size, 1-240 bytes)  

Table 57:    Error Codes 

Value  General Status  
00h  Successful  

E1h  Unknown command  

E2h  Invalid command data length  
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E5h FDL error (see extended error code) 

E6h DPV1 error (see extended error code) 

E7h  Another command is already in progress for this slave / 
class 2 connection.  

ECh  Invalid data length  

EFh  DPV1 is not initialized  

F1h  Online state expected  

F3h  Invalid slave response  

F5h Class 2 connection is not initialized 

F6h  No space left on command queue  

F7h Command Timeout 

9.3.9  DPV1 Class 2 Write Command 

This command, service code 0x57, writes data to a DPV1 slave using Slave_Number and Index 
parameters through a DPV1 Class 2 connection. 

Table 58:    Request Format 

Tx Offset  Use 

0-3  Command timeout  

4 Connection reference 

5 Slot number where the data should be written 
[0…254] 

6 Index where the data should be written [0…254] 

7 Number of bytes to write [1…240] 

8-247 Data to be written (size, 1-240 bytes) 

Table 59:    Reply Format 

Rx Offset  Use 

0 Number of bytes written [1…240]  

Table 60:    Error Codes 

Value  General Status  
00h  Successful  

E1h  Unknown command  

E2h  Invalid command data length  

E5h FDL error (see extended error code) 

E6h DPV1 error (see extended error code) 

E7h  Another command is already in progress for this slave / 
class 2 connection.  

ECh  Invalid data length  

EFh  DPV1 is not initialized  

F1h  Online state expected  
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F3h  Invalid slave response  

F5h Class 2 connection is not initialized 

F6h  No space left on command queue  

F7h Command Timeout 

9.3.10  DPV1 Class 2 Idle Command 

This command, service code 0x58, sends an Idle command to the DPV1 Class 2 slave. The 
scanner automatically sends an Idle frame to the slave to keep the connection alive, however this 
function can be used to force the Idle.  

Table 61:    Request Format 

Tx Offset  Use 

0-3  Command timeout  

4 Connection reference 

Reply Format: None 

Table 62:    Error Codes 

Value  General Status  
00h  Successful  

E1h  Unknown command  

E2h  Invalid command data length  

E5h FDL error (see extended error code) 

E6h DPV1 error (see extended error code) 

E7h  Another command is already in progress for this slave / 
class 2 connection.  

ECh  Invalid data length  

EFh  DPV1 is not initialized  

F1h  Online state expected  

F3h  Invalid slave response  

F5h Class 2 connection is not initialized 

F6h  No space left on command queue  

F7h Command Timeout 

9.3.11  Extended Error Code 

9.3.11.1  FDL Error (0xE5) 

If an FDL error (0xE5) occurs, the extended error code contains the FDL error code. 

The following table describes the meaning of the FDL_ErrorCode: 
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Table 63:    FDL_ErrorCode Description 

Value  Meaning/Description  
00h  OK  

01h  User error, SAP locked  

02h  No resource for  sending data, tried to send to SAP that 
was not configured 

03h No service available (SAP does not exist) 

04h Access point blocked 

80h  Short character, problems with wiring, termination, etc. 

9Fh  No access 

AFh  Double token detected, problems with wiring, 
termination, etc. 

BFh  Response buffer too small 

8Fh  Noise at SM command, problems with wiring, 
termination, etc. 

9.3.11.2  DPV1 Error (0xE6) 

If a DPV1 error (0xE6) occurs, the extended error code contains the DPV1 error code. Three 
bytes are significant: 

• The first indicates the type of error (its value is always 0x80: DPV1 error) 

• The second consists of two parts: 

• The highest four bits represent the error class 

• The lowest four bits represent the error code 

• The third contains a slave-specific error code 

The following table describes the meaning of the error class and error code of the second error 
byte. 

 

Table 64:    DPV1 Errors 

Error_Class Meaning/Description  Error_Code 
0-9 Reserved  

10= Application 0 = read error 
1 = write error 
2 = module failure 
3 to 7 = reserved 
8 = version conflict 
9= features not supported 
10 to 15 = user specific 
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11= Access 0 = invalid index 
1 = write length error 
2 = invalid slot 
3 = type conflict 
4 = invalid area 
5 = state conflict 
6 = access denied 
7 = invalid range 
8 = invalid parameter 
9 = invalid type 
10 to 15 = user specific 

12= Resource 0 = read constrain conflict 
1 = write constrain conflict 
2 = resource busy 
3 = resource unavailable 
4 to 7 = reserved 
8 to 15 = user specific 

13 to 15 User specific  
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9.4  DPV1 Sample Code 
The PB3-SLC uses a transaction number to handle the processing of DPV1 requests to the M0 
File. This transaction number must change each time a DPV1 request is sent. Reading the last 
transaction number written to M0:Slot.2162 is required and adding 1 to it will be the first 
transaction number you will use to begin DPV1 communication. This transaction number will be 
used in DPV1_INIT. In the sample ladder code, this step is done in the Initialize routine, rung 2 
in SST_PB3_SLC_DPV1_CLASS1.RSS ladder code. 

The code below is a routine called DPV1_INIT. This routine sets the card up for DPV1 
communication and must be called prior to sending DPV1 Class 1 and Class 2 messages. This 
code is included with ladder programs, SST_PB3_SLC_DPV1_CLASS1.RSS, 
SST_PB3_SLC_DPV1_CLASS2.RSS.  



User Reference Guide  SST-PB3-SLC 

 

142  DPV1 Master Functionality 
©2011 Molex Inc.  

Document Edition: 1.2, Document #: 715-0104, Template Edition: 1.1, Template #: QMS-06-045 
Use, duplication or disclosure of this document or any of the information contained herein is subject to the restrictions on page ii of this document. 

 



SST-PB3-SLC  User Reference Guide 

 

DPV1 Master Functionality  143 
©2011 Molex Inc.  

Document Edition: 1.2, Document #: 715-0104, Template Edition: 1.1, Template #: QMS-06-045 
Use, duplication or disclosure of this document or any of the information contained herein is subject to the restrictions on page ii of this document. 

Below is sample code for sending a DPV1_CLASS_1 Read to Slave at station 4, Slot 0, index 
99. The sample code uses N7:0 – N7:1 for Command Timeout, N7:2 (low byte) for station 
address, N7:2(High byte) for slot number, N7:3 (high byte) for number of bytes to Read, and 
N7:3 (Low byte) for index. Integer file N10 is used for DPV1 Request and N11 is used for DPV1 
Response.  

See rung 6 below, when the DPV1_READ request has been processed (transaction number in 
M0:1.2162 matches M1:1.2162), we set a Request processed flag and increment the transaction 
number for next request. If successful (M1:1.2164 Status = 0), we set a success flag. 
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DPV1_CLASS_1 Read_Continued. 
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Below is sample code for sending a DPV1_CLASS_1 WRITE to Slave at station 4, Slot 0, index 
99. The sample code uses N7:0 – N7:1 for Command Timeout, N7:2 (low byte) for station 
address, N7:2(High byte) for slot number, N7:3 (high byte) for number of bytes to write, and 
N7:3 (Low byte) for index. Integer file N10 is used for DPV1 Request and N11 is used for DPV1 
Response. 

See rung 6 below, when the DPV1_Write request has been processed (transaction number in 
M0:1.2162 matches M1:1.2162), we set a Request processed flag and increment the transaction 
number for next request. If successful (M1:1.2164 Status = 0), we set a success flag. 
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DPV1_CLASS_1 WRITE Continued… 
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Below is sample code for sending a DPV1_CLASS_2 INITIATE to Slave at station 4, Slot 0, 
index 99. The sample code uses N7:0 – N7:1 for Command Timeout, N7:2 (low byte) for station 
address. Integer file N10 is used for DPV1 Request and N11 is used for DPV1 Response. 
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DPV1_CLASS_2 INITIATE Continued… 

 The communication reference is returned in N11:5 and then saved in N11:140 so that it 
can be used for other Class 2 commands (Read, Write, Abort, IDLE). 
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Below is sample code for DPV1 Class 2 Read. 
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DPV1 Class 2 Read continued… 
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Below is sample code for DPV1 Class 2 Write. 
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DPV1 Class 2 Write Continued… 
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10 
Diagnostics 

Chapter Sections: 

• Overview 

• Status Register 

• Scanner Firmware Version Number 

• DP Master Slave Status Table 

• DP Master Slave Error Table 

• DP Master Slave Extended Status Table 

• DP Master Error Information Table 

• DP Slave Status Register 

• DP Slave Error Register 

• Diagnostic Counters 

• Summary of Diagnostic Locations 
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10.1  Overview 
This chapter describes system diagnostics.  

The scanner maintains a variety of diagnostic information in the M1 file in the area from 4000 to 
4200. 

10.2  Status Register  
Register 4011 in the M1 file is the PROFIBUS status register. The following tables show 
possible status register values.  

If the status register contains STS_CFG_INTERNAL_ERROR (80h), there has been an internal 
error on the scanner. Record the contents of the errInternal and errArg registers and contact 
Technical Support. ErrInt is stored in the high byte of register 4129 of the M1 file; ErrArg is 
stored in the low byte of register 4130 of the M1 file and also in register 4012 of the M1 file.  

If the status register contains STS_OUT_OF_APBS (81h), the scanner has run out of application 
blocks. The DP Slave uses 2 application blocks, and the DP Master uses 2 application blocks per 
configured Slave. There are a total of 835 application blocks. If you get this error, reduce the 
number of application blocks used.  

If the status register contains STS_HEAP_ALLOC_FAIL (83h) or STS_SH_HEAP_ALLOC_ 
FAIL (84h), there has been an internal error in allocating memory. Contact Technical Support.  

10.3  Scanner Firmware Version Number  
The version number of the scanner firmware is stored in register 4014 in the M1 file. For 
example, if the value is 0116h, the firmware is version 1.22.  
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10.4  DP Master Slave Status Table  
The area in the M1 file from 4000 to 4007 contains the status of the Slaves, one bit per Slave.  
For example, if the Slave at station address 1 is good, bit 1 of register 4000 is set.  

In addition, if the status of all Slaves is good, bit 0 of register 4013 is set. If this bit is 0, one or 
more Slaves have bad status.  

Table 65:    DP Master Slave Status Table 

Register 
Bit / Slave 

15  14  13  12  11  10  9  8  7  6  5  4  3  2  1  0  

4000  15  14  13  12  11  10  9  8  7  6  5  4  3  2  1  0  

4001  31  30  29  28  27  26  25  24  23  22  21  20  19  18  17  16  

4002  47  46  45  44  43  42  41  40  39  38  37  36  35  34  33  32  

4003  63  62  61  60  59  58  57  56  55  54  53  52  51  50  49  48  

4004  79  78  77  76  75  74  73  72  71  70  69  68  67  66  65  64  

4005  95  94  93  92  91  90  89  88  87  86  85  84  83  82  81  80  

4006  111  110  109  108  107  106  105  104  103  102  101  100  99  98  97  96  

4007   126  125  124  123  122  121  120  119  118  117  116  115  114  113  112  

This table can be used in conjunction with the global fault enable, bit 0 of register 4010 in the 
M0 file, and the ignore Slave fault table, 4000-4007 in the M0 file, to fault the SLC if Slaves are 
in error.  

If the global fault enable bit is 0, the scanner will not fault the SLC when there are Slave errors. 
This is the default.  

If the global fault enable bit is 1, the scanner will fault the SLC when there are Slave errors. 
However, you can use the ignore Slave fault table to tell the scanner to ignore the status of some 
Slaves.  

The ignore Slave fault table is organized exactly like the Slave status table above. Set the bit that 
corresponds to a Slave if you want the scanner to ignore the status of that Slave. If the bit for a 
Slave is set, the status is shown in the Slave status table but it is not included in the All Slaves 
Good flag, bit 0 of register 4013.  

Wait an appropriate amount of time before turning on the global fault enable bit, as it takes some 
time for DP Slaves to start up. The amount of time depends on the baud rate and the startup time 
for the Slaves on the network.  
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10.5  DP Master Slave Error Table  
The area in the M1 file from 4020 to 4027 shows Slaves that are in error, one bit per Slave.  
For example, if the Slave at station address 1 is in error, bit 1 of register 4020 is set.  

Table 66:    DP Master Slave Error Table 

Register 
Bit / Slave 

15  14  13  12  11  10  9  8  7  6  5  4  3  2  1  0  

4020  15  14  13  12  11  10  9  8  7  6  5  4  3  2  1  0  

4021  31  30  29  28  27  26  25  24  23  22  21  20  19  18  17  16  

4022  47  46  45  44  43  42  41  40  39  38  37  36  35  34  33  32  

4023  63  62  61  60  59  58  57  56  55  54  53  52  51  50  49  48  

4024  79  78  77  76  75  74  73  72  71  70  69  68  67  66  65  64  

4025  95  94  93  92  91  90  89  88  87  86  85  84  83  82  81  80  

4026  111  110  109  108  107  106  105  104  103  102  101  100  99  98  97  96  

4027   126  125  124  123  122  121  120  119  118  117  116  115  114  113  112  

This table is similar to the Slave status table, except that it shows errors rather than stations with 
good status.  

10.6  DP Master Slave Extended Status Table  
The area in the M1 file from 4030 to 4037 shows Slaves that are reporting extended status, one 
bit per Slave. For example, if the Slave at station address 1 is reporting extended status, bit 1 of 
register 4030 is set.  

Table 67:    DP Master Slave Extended Status Table 

Register 
Bit / Slave 

15  14  13  12  11  10  9  8  7  6  5  4  3  2  1  0  

4030  15  14  13  12  11  10  9  8  7  6  5  4  3  2  1  0  

4031  31  30  29  28  27  26  25  24  23  22  21  20  19  18  17  16  

4032  47  46  45  44  43  42  41  40  39  38  37  36  35  34  33  32  

4033  63  62  61  60  59  58  57  56  55  54  53  52  51  50  49  48  

4034  79  78  77  76  75  74  73  72  71  70  69  68  67  66  65  64  

4035  95  94  93  92  91  90  89  88  87  86  85  84  83  82  81  80  

4036  111  110  109  108  107  106  105  104  103  102  101  100  99  98  97  96  

4037   126  125  124  123  122  121  120  119  118  117  116  115  114  113  112  
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10.6.1  Reading the Extended Status  

To read a Slave’s extended status, write the station number to the diagnostic status station select 
register, register 3828 in the M1 file. The scanner then retrieves the diagnostics for that Slave.  
If the scanner successfully gets the diagnostics, it puts them in registers 3829-3950 and sets the 
high byte of the diagnostic status station select register to 80h. If there is an error in getting the 
extended diagnostics, the scanner sets the high byte of the diagnostic status station select register 
to 40h.  

10.7  DP Master Error Information Table  
The area in the M1 file from 3700 to 3827 contains error information about each Slave, one 
register per station number. This table can be used in conjunction with the Slave status table 
(4000-4007) or the Slave error table (4020-4027) to determine the cause of the error.  

Table 68:    DP Master Error Information Table 

Register 
Bit / Slave 

15  14  13  12  11  10  9  8  7  6  5  4  3  2  1  0  
3700  0  1  2  3  4  5  6  7  8  9  10  11  12  13  14  15  

3716  16  17  18  19  20  21  22  23  24  25  26  27  28  29  30  31  

3732  32  33  34  35  36  37  38  39  40  41  42  43  44  45  46  47  

3748  48  49  50  51  52  53  54  55  56  57  58  59  60  61  62  63  

3764  64  65  66  67  68  69  70  71  72  73  74  75  76  77  78  79  

3780  80  81  82  83  84  85  86  87  88  89  90  91  92  93  94  95  

3796  96  97  98  99  100  101  102  103  104  105  106  107  108  109  110  111  

3812  112  113  114  115  116  117  118  119  120  121  122  123  124  125  126   

The scanner sets various values in the high byte to indicate the cause of any Slave problems. 
Some errors occur during parameterizing the Slave, others occur at runtime. If there are multiple 
errors, only the last one is shown. The host acknowledges these errors by clearing the register.  
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Table 69:    Error Status Table 

Value  Cause  

01h  Failure while trying to configure Slave.  

02h  Slave’s real ID does not match Slave’s configured ID.  

03h  Frame delivery problem while updating Slave data.  

04h  Frame delivery problem while reading Slave 
diagnostics.  

05h  Error in diagnostic status byte #1 during 
configuration.  

06h  Error in diagnostic status byte #2 during 
configuration.  

07h  Error in diagnostic status byte #1 during diagnostic 
read.  

08h  Error in diagnostic status byte #2 during diagnostic 
read.  

09h  Station address from diagnostic read does not match.  

0ah  Timeout waiting for I/O update.  

0bh  Warning: Slave watchdog is not enabled.  

For some values in the high byte, the scanner provides additional information in the low byte to 
help pinpoint the cause of the problem.  

high byte = 01h (failure while trying to configure Slave) 

The following tables list possible values in the low byte. 
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Table 70:    Error 01  

Value  Meaning  

1  No response or NAK after sending the first 
diagnostic status request to the Slave.  

2  No response or NAK after sending parameter 
data to the Slave.  

3  No response or NAK after sending 
configuration check data to the Slave.  

4  No response or NAK after sending the second 
diagnostic status request to the Slave.  

5  Invalid response after sending the first 
diagnostic status request to the Slave.  

6  Invalid response after sending parameter data 
to the Slave.  

7  Invalid response after sending configuration 
check data to the Slave.  

8  Response to configuration check packet was 
non-zero length (Slave should never return 
anything).  

9  Invalid response after sending the second 
diagnostic status request to the Slave.  

high byte = 03h (frame delivery problem while updating Slave data) 

Table 71:    Error 03  

Value  Meaning 

1  Error in data update during configuration.  

2  No response or NAK when updating data while 
online.  

high byte = 04h (frame delivery problem while reading Slave diagnostics) 
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Table 72:    Error 04 

Value  Meaning 

1  Invalid response when reading Slave 
diagnostics while online.  

2  No response or NAK when reading Slave 
diagnostics while online.  

high byte = 05h (error in diagnostic status byte #1 during configure)  

The value in the low byte depends on the value returned by the Slave in the first station status 
byte when the Master reads diagnostics during configuration. Mask the value with 0F5h, and any 
bits that are set in the result should not be set. Mask the value in the low byte with 02h, and bit 1 
should be set.  
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The bits in station status byte 1 are:  

Table 73:    Error 05 and Error 07 

Bit  Meaning  

7  DP Slave has been parameterized by another 
Master.  

6  Slave received an invalid parameter frame, 
wrong Ident, wrong length, invalid parameters, 
etc.  

5  Invalid response from the Slave.  

4  Master requested a function that the Slave 
does not support.  

3  An entry exists in the Slave-specific diagnostic 
area.  

2  Configuration check data for the Slave was 
incorrect.  

1  Slave is not ready for data transfer.  

0  DP Slave non-existent.  

high byte = 07h (error in diagnostic status byte #1 during diagnostic read)  

The value in the low byte depends on the value returned by the Slave in the first station status 
byte when the Master reads diagnostics while online. Mask the value with 0F7h, and any bits that 
are set should not be set. The bits in station status 1 are shown in the above table.  

high byte = 06h (error in diagnostic status byte #2 during configure)  

The value in the low byte depends on the value returned by the Slave in the second station status 
byte when the Master reads diagnostics during configuration. Mask the value with 060h and any 
bits that are set in the result should not be set. Mask the value in the low byte with 04h, and bit 2 
should be set.  
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The bits in station status byte 2 are:  

Table 74:    Error 06 and Error 08 

Bit  Meaning  

7  Slave has been marked inactive by the Master.  

6  Reserved.  

5  The Slave has received a Sync command.  

4  The Slave has received a Freeze command.  

3  The Slave watchdog has been activated.  

2  The Slave sets this bit to 1.  

1  Th Slave is requesting a diagnostic read.  

0  The Slave is requesting reparameterization  

high byte = 08h (error in diagnostic status byte #2 during diagnostic read)  

The value in the low byte depends on the value returned by the Slave in the second station status 
byte when the Master reads diagnostics while online. Mask the value with 080h, and any bits that 
are set should not be set. Mask the value in the low byte with 04h, and bit 2 should be set. The 
bits in station status 2 are shown in the above table.  

10.8  DP Slave Status Register  
• The scanner reports the status of its DP Slave operation by setting bits in the Slave status 

register, register 4017 in the M1 file.  

• The scanner sets bit 6, SLV_STS_RUN_MODE, if it’s being scanned by a DP Master in 
Run mode.  

• The scanner sets bit 7, SLV_STS_OK, if the current Slave status is OK. This means 
parameterization was successful and the Slave watchdog hasn’t timed out.  
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10.9  DP Slave Error Register  
The scanner module sets the Slave error register, register 4018 in the M1 file, to the following 
values to report various error conditions in its operation as a DP Slave. If there are multiple 
errors, the register contains the value for the last error encountered.  

Table 75:    DP Slave Error Table 

Error  Value  Meaning 

SLV_ERR_ID_MISM  01h  ID from Master does not match 
configured ID. Slave will not 
communicate with the Master. 

SLV_ERR_READY_TIME_MISM  02h  PfbReadyTime does not match 
what Master sent. The card can 
communicate as a Slave even if 
the times are different, but you 
may experience network errors. 

SLV_ERR_UNSUP_REQ  03h  Master is requesting Freeze or 
Sync, which is not supported.  

SLV_ERR_RX_LEN_MISM  04h  Length of data from Master is 
incorrect. The card won‘t 
communicate as a Slave. 

SLV_ERR_TX_LEN_MISM  05h  Length of data to Master is 
incorrect. The card won‘t 
communicate as a Slave. 

SLV_ERR_WD_FACT_INV  06h  One of the watchdog factors from 
the Master was 0. This is not 
allowed. 

SLV_ERR_TIME_OUT  07h  Slave watchdog timeout. The 
Slave has gone offline and must 
be reinitialized by the Master.  
Check response timeout. 

SLV_ERR_WARN_WD_DIS  08h  Slave timeout watchdog disabled 
from Master.  

All these errors, except TIME_OUT, happen when the Slave is being parameterized by the 
Master.  
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10.10  Diagnostic Counters  
The scanner maintains a variety of diagnostic counters to indicate:  

• General statistics on messages sent and received, for example  

• The state of the Master  

• Network statistics  

The counters are located in the M1 file from 4100 to 4200.  

To reset these counters to 0, set the low byte of register 4100 to a non-zero value. The scanner 
then clears the counters to 0 and clears register 4100 back to 0.  

The counters are also cleared when you put the SLC in Program mode.  

In the following tables, counters with a name beginning with “diag” or “err” roll over to zero 
when they reach their maximum value. “L” indicates low byte; “H” indicates high byte.  
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Table 76:    Diagnostic Counters 

Name  Location  Meaning 

pfbInitCtrs  4100L  If non-zero, scanner clears counters.  

errLanOffline  4100H  LAN went offline because of errors.  

diagConf  4101  Total confirmations.  

diagInd  4102  Total indications.  

errNotOk  4103  Total not OK confirmations and 
indications.  

diagTokHldTime  4104-4105  Instantaneous token hold time.  

diagMinTokHldTime  4106-4107  Minimum token hold time.  

diagMasterUpdate  4108  Master I/O update cycles completed.  

errMasErr  4109L  Master->DP Slave errors.  

errMasReConfig  4109H  Master->DP went offline and had to be 
reconfigured.  

diagMasScanTime  4110-4111  Master scan time (µs).  

diagMasMaxScanTi
m e  

4112-4113  Maximum Master scan time (µs).  

diagSlaveUpdate  4114  Slave updates.  

errSlvErr  4115L  Slave configuration failures.  

errSlvTout  4115H  Slave watchdog timeouts.  

diagLay2MsgOk  4116  FDL messages sent OK.  

errLay2MsgNotOk  4117L  FDL message errors.  

diagLay2SapOk  4118  FDL SAP requests processed OK.  

errLay2SapNotOk  4119L  FDL SAP errors.  

errInvReqLen  4124L  Invalid request length errors.  

errFifo  4124H  FIFO overflow errors.  

errRxOverun  4125L  Receive overrun errors.  

errDblTok  4125H  Double token errors.  

errRespErr  4126L  Response errors.  
errSyniErr  4126H  SYNI errors.  

errNetTout  4127L  Network timeout errors.  

errHsa  4127H  Station higher than HSA was heard.  

errStn  4128L  Duplicate station detected.  

errPasTok  4128H  Unable to pass token.  

errLasBas  4129L  Active station list invalid.  

ErrInternal  4129H  Internal error.  

errArg  4130L  Internal error.  
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10.10.1  General Statistics  

These counters relate to the overall operation of the scanner on PROFIBUS.  

Table 77:    General Statistics Counters 

Name  Location  Meaning 

errLanOffline  4100H  Increments when the LAN encounters 
errors and goes offline. 

diagConf  4101  Counts total confirmations (good replies 
to messages that this station has 
generated). 

diagInd  4102  Counts total indications (unsolicited 
messages to this station). 

errNotOk  4103  Counts total Not OK confirmations and 
indications (total bad replies and bad 
unsolicited messages). 

diagTokHldTime  4104-4105  Instantaneous token hold time, in Tbits. 
This is the time available to send 
messages when the scanner gets the 
token. 

diagMinTokHldTime  4106-4107  Minimum token hold time, in Tbits. This is 
the minimum value of diagTokHldTime.  
If this number is 0, you may need to 
increase the target token rotation time or 
delta TTR in COM PROFIBUS. 
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10.10.2  DP Master Statistics  

These counters relate to the scanner’s operation as a DP Master. 

Table 78:    DP Master Statistics Counters 

Name  Locatio
n  

Meaning 

diagMasterUpdate  4108  The number of Master I/O update 
cycles completed. 

errMasErr  4109L  The number of DP Master to DP 
Slave communication errors. 
Incremented anytime the message 
failed because of retries exceeded, 
and so on. 

errMasReConfig  4109H  The number of times a DP Slave 
went offline and had to be 
reconfigured, e.g., 120the scanner 
was actively updating a node and got 
a faulty message. This counter 
increments after the scanner has 
retried the message the number of 
times specified in pfbMsgRetryLimit 
(set by COM PROFIBUS). 

diagMasScanTime  4110-
4111  

Contains the instantaneous Master 
scan time in microseconds, i.e., the 
time to scan all the Slaves assigned 
to this Master. The scanner adds 100 
microseconds to the measured time 
to allow for overhead in starting the 
timer, and so on. 

diagMasMaxScanTime  4112-
4113  

Contains the maximum value that 
diagMasScanTime has reached since 
it was last cleared. 
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10.10.3  DP Slave Statistics  

These counters relate to the operation of the card as a DP Slave.  

Table 79:    DP Slave Statistics Counters 

Name  Location  Meaning 

diagSlaveUpdate  4114  Increments when the card receives 
an I/O data update from the Master. 

errSlvErr  4115L  Increments when there are errors 
while the Master is parameterizing 
the Slave. 

errSlvTout  4115H  Increments when the Slave hasn’t 
received a message from the Master 
within the Master timeout period. 
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10.10.4  ASPC2 PROFIBUS Controller Statistics  

The ASPC2 LAN controller maintains the following counters. They are all 1 byte long. When 
these counters reach 255, they hold at 255 until cleared.  

Table 80:    ASPC2 Controller Counters 

Counter Name Function 

errInvReqLen This is the low byte of register 4124. It counts invalid request length errors. These errors occur 
when the scanner software gives the LAN controller a message that is too long. This error is an 
internal error and should never occur. 

errFifo This is the high byte of register 4124. It counts FIFO overflow errors. These errors occur when the 
LAN controller can’t write to memory fast enough. This error is an internal error and should never 
occur. 

errRxOverun This is the low byte of register 4125. It counts receive overrun errors. This error is an internal error 
and should never occur. 

errDblTok This is the high byte of register 4125. It counts double token errors. These errors may occur when 
more than one node thinks it has the token or due to wiring errors, duplicate nodes, and so on. 
The scanner withdraws to the “not hold token“ state (decides it doesn‘t have the token) and waits 
until it gets the token passed to it again. 

errRespErr This is the low byte of register 4126. It counts response errors when a message failed or there was 
no response from the destination. This error may be due to bad hardware or faulty wiring. 

errSyniErr This is the high byte of register 4126. It indicates general network errors. These errors occur when 
there are problems on the network but before a network timeout error occurs. 

errNetTout This is the low byte of register 4127. It counts network timeout errors. These errors occur when the 
network is dead. If a timeout occurs, the scanner enters the claim token state. 

errHsa This is the high byte of register 4127. It increments when a station higher than the set high station 
address is heard. If the scanner is going online, it increments the counter and stays offline. 

errStn This is the low byte of register 4128. It increments when a duplicate station is detected. If this error 
occurs when the scanner is going online, the scanner increments the errStn counter and stays 
offline. 

errPasTok This is the high byte of register 4128. It increments when the scanner is unable to pass the token. 
This is usually caused by bad wiring (usually shorted) or other hardware problems. The scanner 
tries to pass the token, fails to hear its own token pass message, and puts itself offline. 

errLasBad This is the low byte of register 4129. It increments when the active station list on the ASPC2 LAN 
controller is invalid because of multiple network errors. This error is caused by bad wiring or 
hardware. 

errInternal This is the high byte of register 4129. This location is reserved. If a fatal error occurs, the value in 
this register may indicate the source of the problem. Record it for Technical Support. However, the 
scanner uses this location for other purposes. If there is a value in this location, it doesn‘t 
necessarily indicate that a fatal error has occurred. 

errArg This is the low byte of register 4130. This location is reserved. If a fatal error occurs, the value in 
this register may indicate the source of the problem. Record it for Technical Support. However, the 
scanner uses this location for other purposes. If there is a value in this location, it doesn‘t 
necessarily indicate that a fatal error has occurred. 
The scanner also copies this counter to the low byte of register 4012. 
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10.11  Summary of Diagnostic Locations  
The following tables summarize the locations used.  

10.11.1  M1 File  

Table 81:    M1 File Diagnostic Locations 

Locations  Use  

3700-3827  DP Master error information.  

3828  DP Master diagnostic station select.  

3829-3950  DP Master diagnostic status buffer.  

4000-4007  Slave status table.  

4011  PROFIBUS status.  

4012  errArg.  

4013  Bit 0 = all Slaves good flag.  

4014  Firmware revision.  

4017  DP Slave status.  

4018  DP Slave error.  

4020-4027  DP Master Slave error table.  

4030-4037  DP Master extended status table.  

4100-4200  Diagnostic counters.  

10.11.2  M0 File 

Table 82:    M0 File Diagnostic Locations 

Locations  Use  

4000-4007  Ignore Slave fault table.  

4010  Global fault enable.  
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11.1  Upgrading the Scanner Firmware  
Use the serial CONFIG port on the front of the scanner to upload configuration files to the 
scanner.  

The serial cable for a standard PC COM port must have lines 2 and 3 swapped. It doesn’t require 
handshaking. Pins 2 and 3 are wired the same as a PC 9-pin COM port.  

Connect to the serial port using any communication software, such as HyperTerminal. The 
scanner serial port supports any baud rate from 9600 baud to 115 kbaud, with no parity, 8 data 
bits, 1 stop bit and no Flow Control. The scanner automatically detects the baud rate being used. 
115 Kbaud is recommended. 

To upgrade the scanner firmware, follow these steps: 

1. Cycle power on the SLC.  

2. When the SLC is powering up, the SYS LED flashes green, red, amber then solid red for 
approximately 3 seconds before turning off. While it is flashing, hit the exclamation mark 
(!) in your communication software to tell the scanner that you want to upload software. 
You may need to press it several times while the scanner tries to autodetect the baud rate.  

The LEDs flash red alternately to tell you the scanner is in system configuration mode. 
The commands available are:  

Table 83:    Download Commands 

Command Description 

ver pb3slc.ss3  Displays the current ss3 firmware revision number. Typing “ver” by itself displays 
boot code version  

help Displays the available commands  

ry pb3slc.ss3 Loads new pb3slc.ss3 into flash 

burn Loads new pb3slc.ss4 into flash 

run pb3slc.ss3 Exits system configuration mode 

 

3. Type “ry pb3lsc.ss3”. The scanner responds with a query.  

4. Using your communication software, initiate a Ymodem send of the module firmware 
file. For Hyperterminal, this is done by selecting the Transfer menu and choosing Send 
File.  Set the protocol to Ymodem, browse for the firmware file and then press Send. 
When the download is complete, the module automatically programs it into flash. 

5. When the module has been programmed into flash, use the “ver pb3slc.ss3” command to 
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confirm that the version number is correct. 

6. Use the “run pb3slc.ss3” command to exit System Configuration mode and startup. The 
scanner turns off the SYS LED. 

7. Type “burn”. 

8. Initiate a Ymodem send of the firmware module “pb3slc.ss4”, using the communication 
software.  

9. Wait for a “Success!! Please Restart Module” message. 

10. Cycle power on the module. 
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12.1  Network Parameter Default Tables 
The following tables show the default values assigned by the scanner for the network parameters. 
The values depend on: 

• The baud rate  

• Whether there are repeaters on the network  

• Whether there are FMS devices on the network  

Idle time 1 is the amount of time the scanner waits after it receives a response before it sends. 
This corresponds to the PROFIBUS Idle Time.  

Idle time 2 is the amount of time the scanner waits after it sends before it sends again. This 
corresponds to the PROFIBUS Max TSDR. 

Table 84:    No Repeater, No FMS  

Baud Rate Slot Time Idle Time 1  Idle Time 2 Ready Time Quiet Time 

9600  100  37  60  11  0  

19200  100  37  60  11  0  

31.25 K 100  37  60  11  0  

45.45 K 100  37  60  11  0  

93.75 K  100  37  60  11  0  

187.5K  100  37  60  11  0  

500K  200  37  100  11  0  

1.5M  300  37  150  11  0  

3M  400  45  250  11  3  

6M  600  55  450  11  6  

12M  1000 75  800  11  9  
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Table 85:    No Repeater, FMS 

Baud Rate Slot Time Idle Time 1 Idle Time 2 Ready Time Quiet Time 

9600  125  37  60  30  0  

19200  250  61  120  60  0  

31.25 K 300 61 120 60 0 

45.45 K 400 61 120 60 0 

93.75 K  600  126  250  125  0  

187.5K  1500  251  500  250  0  

500K  3500  251  1000  250  0  

1.5M  3000  151  980  150  0  

3M  400  45  250  11  3  

6M  600  55  450  11  6  

12M  1000 75  800  11  9  

Table 86:    Repeater, No FMS 

Baud Rate Slot Time Idle Time 1 Idle Time 2 Ready Time Quiet Time 

9600  100  37  60  11  0  

19200  100  37  60  11  0  

31.25 K 100  37  60  11  0  

45.45 K 100  37  60  11  0  

93.75 K  100  37  60  11  0  

187.5K  100  37  60  11  0  

500K  200  37  100  11  0  

1.5M  300  37  150  11  0  

3M  400  45  250  11  3  

6M  600  55  450  11  6  

12M  1000  75  800  11  9  
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Table 87:    Repeater, FMS 

Baud Rate Slot Time Idle Time 1  Idle Time 2 Ready Time Quiet Time 

9600  125  37  60  30  0  

19200  250  61  120  60  0  

31.25 K 300 61 120 60 0 

45.45 K 400 61 120 60 0 

93.75 K  600  126  250  125  0  

187.5K  1500  251  500  250  0  

500K  3500  251  1000  250  0  

1.5M  3000  151  980  150  0  

3M  400  45  250  11  3  

6M  600  55  450  11  6  

12M  1000  75  800  11  9  
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M0 and M1 Files 

Chapter Sections: 
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• Addressing M0 and M1 Files 
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13.1  Overview 
The following data is based on information in the SLC 500 Instruction Set Reference Manual, 
Allen-Bradley publication 1747.6.15, and is provided here for reference. 

M0 and M1 files reside in specialty I/O modules only. There is no image for these files in the 
processor memory. This means that when an application running on the SLC accesses the data, 
the SLC must go out to the module and read the data. The contents of these files depend on the 
specialty I/O module's function. Both types of files are considered read/write files by the SLC 
processor. M0 and M1 files can be addresses in your ladder program and they can also be acted 
upon by the specialty I/O module, independent of the processor scan. It is important to keep the 
following in mind when creating and applying your ladder logic. 

During the processor scan, M0 and M1 data can be changed by the processor, according to ladder 
diagram instructions addressing the M0 and M1 files. During the same scan, the specialty I/O 
module can change the M0 and M1 data, independent of the rung logic applied during the scan. 

13.2  Addressing M0 and M1 Files 
The addressing format for M0 and M1 files is Mf:e.s/b, where: 

• f = file type, 0 or 1 

• e = slot (1 to 30) 

• s = word (0 to maximum supplied by module) 

• b = bit (0 to 15) 
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13.2.1  Restrictions on Using M0-M1 Data File Addresses 

M0 and M1 data file addresses can be used in all instructions except the OSR instruction and the 
instruction parameters noted below. 

Table 88:    M0 and M1 File Access Restrictions 

Instruction  Parameter (Uses File Indicator #)  

BSL,BSR  File (bit array)  

SQO, SQC, SQL  File (sequencer file)  

LFL, LFU  LIFO (stack)  

FFL, FFU  FIFO (stack)  

13.2.2  Monitoring Bit Addresses 

M0 and M1 Bit Monitoring Disabled 

When you monitor a ladder program in Run or Test mode, the following bit instructions, 
addressed to an M0 or M1 file, are indicated as false (regardless of their actual true/false logical 
state): 

--| |-- --|/|-- --( )-- --(L)-- --(U)-- 

M0 and M1 Bit Monitoring Enabled 

The SLC 5/03, SLC 5/04 and SLC 5/05 processors allow you to monitor the actual state of each 
addressed M0/M1 address (or data table). The highlighting appears normal when compared with 
other processor data files. The SLC 5/03’s performance will be reduced to the degree of M0/M1 
referenced screen data. 

If you need to show the state of the M0 or M1 addressed bit, you can transfer the state to an 
internal processor bit. 

Transferring Data between Processor Files and M0/M1 Files 

The SLC processor does not contain an image of the M0 or M1 file. As a result, you must edit 
and monitor M0 and M1 file data via instructions in your ladder program. For example, you can 
copy a block of data from a processor data file to an M0 or M1 data file or vice versa using the 
COP instruction in your ladder program. 
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Access Time 

During the program scan, the SLC processor must access the scanner card to read or write M0 or 
M1 data. This access time must be added to the execution time of each instruction referencing 
M0 or M1 data. The SLC 500 Instruction Set Reference Manual contains details about this 
access time. 

Minimizing the SLC Scan Time 

You can limit the SLC processor scan time by minimizing the use of instructions that address M0 
or M1 files. 
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A.1  Technical Data 

Table 89:    Technical Data for the SST-PB3-SLC Module 

Part Number  SST-PB3-SLC  

Function  SLC-500 scanner for PROFIBUS networks  

SLC Interface  32 words direct Input and Output data  

 1000 words of M0 and M1 mapped data  

Environmental  Storage temperature -40°C to 85°C  

 Operating temperature 0°C to 50°C  

 Operating RH level 5% to 95%  

 Pollution Degree 1 - no pollution, or only non-conductive or 
non-corrosive pollution  

Backplane 
Current 
Consumption  

750 mA @ 5 VDC*  

*The 5VDC backplane voltage must be from a supply delivering Separated Extra Low Voltage 
(SELV).  
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B.1  CE Compliance 
Marking of this equipment with the  symbol indicates compliance with with European Council 
Directive 89/336/EEC - The EMC Directive as amended by 92/31/EEC and 93/68/EEC. 

 Warning 
This is a Class A product. In a domestic environment, this product may 
cause radio interference, in which case you may be required to take 
adequate measures. 

 

 Caution 
This equipment is neither designed for, nor intended for operation in 
installations where it is subject to hazardous voltages and hazardous 
currents. 

 

 Note 
To maintain compliance with the limits and requirements of the EMC 
Directive, it is required to use quality interfacing cables and connectors 
when connecting to this device. Refer to the cable specifications in the 
Hardware Guide for the selection of cable types. 

 

 

Note 
The Backplane voltage supply for this equipment must be delivered as 
Separated Extra Low Voltage (SELV). 

 

 



SST-PB3-SLC  User Reference Guide 

 

Warranty and Support  189 
©2011 Molex Inc.  

Document Edition: 1.2, Document #: 715-0104, Template Edition: 1.1, Template #: QMS-06-045 
Use, duplication or disclosure of this document or any of the information contained herein is subject to the restrictions on page ii of this document. 

C 
Warranty and Support 

Appendix Sections: 

• Warranty 

• Reference Documents 

• Technical Support 



SST-PB3-SLC   User Reference Guide 

 

190  Warranty and Support 
©2011 Molex Inc.  

Document Edition: 1.2, Document #: 715-0104, Template Edition: 1.1, Template #: QMS-06-045 
Use, duplication or disclosure of this document or any of the information contained herein is subject to the restrictions on page ii of this document. 

C.1  Warranty 
For warranty information pertaining to this product, refer to 
http://www.molex.com/images/woodhead/woodhead_limited_warranty.pdf.  

C.2  Reference Documents 

Table 90:    Reference Documents 

For… Read this Document Document Number 

An overview of SLC products SLC 500 System Overview  A-B 1747-2.30 

A description of how to install and use the 
SLC 500 PLC 

Installation and Operation Manual for Modular 
Hardware Style Programmable Controllers 

A-B 1747-6.2 

An index of Allen-Bradley publications Allen-Bradley Publication Index  A-B SD499 

For information on PROFIBUS, refer to one of the following:  

• PROFIBUS Standard DIN 19 245, parts 1 and 3. Part 1 describes the low-level protocol 
and electrical characteristics. Part 3 describes the DP protocol.  

• European Standard EN 50170  

• ET 200 Distributed I/O System Manual, 6ES5 998-3ES22  

• IEEE 518 Guide for the Installation of Electrical Equipment to Minimize Electrical Noise 
Input to Controllers 

C.3  Technical Support 
Please ensure that you have the following information readily available before calling for 
technical support: 

• Card type and serial number 

• Computer’s make, model, CPU speed and hardware configuration (other cards installed) 

• Operating system type and version 

• Details of the problem you are experiencing: firmware type and version, target network 
and circumstances that may have caused the problem 

http://www.molex.com/images/woodhead/woodhead_limited_warranty.pdf
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C.3.1  Getting Help 

Technical support is available during regular business hours by telephone, fax or email from 
www.Molex.com. Documentation and software updates are also available on the website. 

North America 

Canada: 
Tel: +1-519-725-5136 
Fax: +1-519-725-1515 
Email: WoodheadSupportNA@molex.com 

Europe 

France: 
Tel: +33 2 32 96 04 22 
Fax: +33 2 32 96 04 21 
Email: ic.support.eu@molex.com 

Germany: 
Tel: +49 7252 9496 555 
Fax: +49 7252 9496 99 
Email: WoodheadIC.SupportDE@molex.com 

Italy: 
Tel: +39 010 5954 052  
Fax: +39 010 5954 052  
Email: WoodheadIC.SupportIT@molex.com 

Other countries: 
Tel: +33 2 32 96 04 23 
Fax: +33 2 32 96 04 21 
Email: WoodheadIC.SupportEU@molex.com

http://www.molex.com/
mailto:WoodheadSupportNA@molex.com
mailto:ic.support.eu@molex.com
mailto:WoodheadIC.SupportDE@molex.com
mailto:WoodheadIC.SupportIT@molex.com
mailto:WoodheadIC.SupportEU@molex.com
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Asia-Pacific 

Japan: 
Tel: +81 46-265-2428 
Fax: +81 46 265 2429 
Email: WoodheadIC.SupportAP@molex.com 

Singapore: 
Tel: +65 6268 6868 
Fax: +65 6264 6055 
Email: WoodheadIC.SupportAP@molex.com 

China: 
Tel: +86 21 5835 9885 
Fax: +86 21 5835 9980 
Email: WoodheadIC.SupportAP@molex.com 

For the most current contact details, please visit http://www.molex.com. 
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